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実習スケジュール 

1 日目 

9:30-10:20     スケジュールの説明など 

10:20-10:45    ｃDNA 合成準備 

10:45-12:45    cDNA 合成反応開始（2h） 

・10：45-11：45 実験に必要な試薬、器具 

ラベル化反応の概要 

DNA マイクロアレイの基礎 

・11:45-12:45  <昼食 （1h）> 

12:45-13:10    cRNA 増幅&ラベル化準備 

13:10-15:10    cRNA 増幅＆ラベル化反応（2h） 

・13:10-14:10   サンプル及び cRNA のチェック方法の説明 

             マイクロアレイ実験に役立つストラタジーン製品のご紹介 

・14:10-14:20   <休憩> 

・14:20-15:00   ハイブリチャンバの組み立てとハイブリの練習 

15:10-15:50    cRNA 精製 

15:50-16:40    バイオアナライザ、NanoDrop による cRNA のチェックと濃度測定 

16:40-16:50             フラグメンテーションの準備 

16:50-17:20    フラグメンテーション（30min） 

17:20-17:30    ハイブリダイゼーション準備 

17:30-       ハイブリダイゼーション開始 

 

2 日目 

9:30-9:40   スキャナの基本性能 

9:40-9:50   オゾン対策の説明 

9:50-10:30              アレイ洗浄方法の説明・解体練習 

10:30-11:10  アレイ洗浄、スキャナ操作 

11:10-11:20              <休憩> 

11:20-12:00  DNA マイクロアレイの遺伝子情報 

12:00-13:00   <昼食 （1h）> 

13:00-13:20   イメージファイルの解析方法 

13:20-14:20   Feature Extraction アルゴリズム(2 カラー実験)の説明 

14:20-14:40   <休憩> 

14:40-16:00   Feature Extraction による数値化 

16:00-16:40   遺伝子発現解析ソフト（GeneSpring GX）デモ 

16:40-17:00  Q&A、まとめ 

17:00-17:30  1 カラー実験の Normalization 法の説明、解析概念 
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1． はじめに 

 

アジレント・テクノロジーでは、マイクロアレイ実験をされる実務者の方を対象に DNA マイクロアレイ カ

ストマニュースを配信しています。実験プロトコルのアップデート・新製品のご案内・実験に関するトラブ

ルシュート・試薬や消耗品の保存など、実験を成功させるためのテクニカルサポートに内容を限定して、

月 1 回程度 E-mail でお送りしています。受信をご希望の方は「DNA マイクロアレイ カストマニュース配

信希望」と明記して、お名前・ご所属・配信を希望する E-mail アドレスを下記宛先までお知らせください。 

 email_japan@agilent.com 

 

 

DNA マイクロアレイ実験の流れ 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

http://www.cs.washington.edu/homes/jbuhler/research/array/  より一部改変 

 

アジレントの オリゴDNA マイクロアレイは、インクジェット技術をベースに、各遺伝子のシークエンスから

設計された 60mer の DNA オリゴプローブを、基板上に直接 in-situ 合成する方法で製造されています。

In-situ 合成により、非常に均質なスポットをしかも高密度でアレイ上に作成できるため、アレイ実験の再

現性が非常に向上し、信頼性の高い結果を得ることが出来ます。 

 

 

 

mailto:email_japan@agilent.com
http://www.cs.washington.edu/homes/jbuhler/research/array/
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本キットは、生物学的に異なる 2 つの試料間の遺伝子発現の違いを、相対的に比較する実験のために

作成されています。2 つの試料から抽出した RNA をもとに、cDNA を合成し、さらに T7RNA ポリメラーゼ

を使ってアンチセンス cRNA を合成します。この時の反応液に、Cyanine3 と Cyanine5 でラベル化され

た CTP を入れることにより、cRNA 合成時に蛍光標識が取り込まれ、ラベル化が行われます。それらの

標識 cRNA をマイクロアレイ上で、競合的にハイブリダイゼーションさせます。 

アジレントは本オリゴ DNA マイクロアレイに使用するラベル化反応用のキットとして、Quick Amp 

Labeling Kit, Two-color （製品番号 5190-0444）の使用を強くお奨めしています（本キットには

Cyanine3, 5-CTP が含まれます）。Agilent 社のラベル化キットは、Agilent 社の DNA マイクロアレイに

あわせて最適化されています。他のプロトコールで調製した cRNA を、本プロトコールに従ってハイブリ

ダイゼーションに用いた場合、問題の生じるケースがあります。Agilent 社以外のラベル化キットを用いて

問題が生じた場合、サポートの対象外になりますことをご了解ください。 

本操作実習テキストは、Quick Amp Labeling Kit を用いた場合の手順について、記載しています。 

 

Ver.5.7_JP での更新点 

 実験に使用する Agilent キット fragmentation buffer のチューブに含まれる内容量の記載を 

改訂しました。 

 必要なものリストを見やすくしました。 

 ラベル化 cRNA の NanoDrop による評価の記述を簡便化しました。 

 ハイブリエイドの使い方の絵を一部修正しました。 

 オーブンの写真を型番 G2545A のものに変更しました。 

 Appendix：FE 用 Protocol のダウンロードサイトページのリンクを修正し、「現在」の日付を 

2017 年 4 月に変更しました。 

 デザインファイルのダウンロード方法のリンクや情報を修正し、「現在」の日付を 

2017 年 4 月に変更しました。 

 

Ver.5.7 での更新点 

 ラベリング試薬が、the Low RNA Input Linear Amplification Kit PLUS から Agilent Quick 

Amp Labeling Kit に変更になりました  

 アレイ洗浄のアーティファクトリスクの軽減のため、Triton X-102 が GE Wash Buffer1 と 2 に加え

られました。  

 必要なものリストに、Triton X-102 が加えられました。 

 Agilent Stabilization and Drying Solution による洗浄ステップでの、アセトニトリルでの洗浄時間が

短縮されました。 

2015 年 8 月変更点 

 保証期間の記述を変更しました。 
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プロトコルは予告なく変更になることがあります。プロトコルを日本語化するにあたり、作業時間が発生

するため、日本語プロトコルは英語の最新バージョンに比べて、どうしても遅れが生じます。製品ご購入

の際は、必ず製品添付の英語版プロトコルの Version をお確かめの上、日本語版が古い場合は、最新

の英語版を参照くださるようお願い申し上げます。  
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2．使用するキットの確認 

 

Quick Amp Labeling Kit, two-color 20 反応分 

（製品番号 5190-0444） （※本キットは、Cyanine 3、5-CTP を含みます） 

＜内訳＞ 

 Cyanine 3-CTP および Cyanine 5-CTP （10 反応分チューブ×各 1 本） 

 Quick Amp Labeling  Kit 単品（製品番号 5190-0447 

この製品番号の商品は Cyanine 色素が含まれません。） 

 

Component  Volume 

MMLV-RT 45 µL   

T7 Promotor Primer 30 µL  

RNase Inhibitor 25 µL  

Inorganic Pyrophosphatase 15 µL  

5x First Strand Reaction buffer 195 µL   

4x Transcription buffer 430 µL  

10 mM dNTP mix 25 µL  

NTP mix 175 µL  

0.1M DTT 230 µL  

T7 RNA Polymerase 20 µL  

50% PEG (Polyethylene glycol 140 µL  

 

※本キットは-20℃で保存してください。 

※Cy3-CTPは開封前は-20℃、融解後は4℃で保存してください。 

※Cyanine色素のみの販売はしておりません。 

 

アジレント RNA Spike-In キット 

（製品番号 5188-5279） 

 Spike A Mix (10uL) 

 Spike B Mix (10uL) 

 Dilution buffer (1.2mL) 

※全ての試薬は-80℃で保存してください。 
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アジレント Gene Expression Hybridization Kit     

（製品番号 5188-5242） 

Component 

25x フラグメンテーションバッファ  (400-500 uL) 

2x GE Hybridization Buffer HI-RPM (1.25mL x 2 本) 

10 X Blocking Agent (凍結乾燥) 

※本キットは開封するまでは室温で保存してください。 

※10x Blocking Agent を調製した後は、この試薬のみ-20℃で保存してください。 

※本キットの使用可能アレイ数は下記のようになります。 

244K 10 アレイ 

2x105K 20 アレイ 

4x44K 45 アレイ 

8x15K 100 アレイ 

アジレント Gene Expression Large Volume Hybridization Kit 

（製品番号 5190-0404） 

※本キットは Gene Expression Hybridization Kit と比べて各フォーマットとも 10 倍のアレ

イ数に使用可能です。 

※Large Volume Hybridization Kit の各試薬は個別に購入することが可能です。 

 2 x Hi-RPM Hybridization Buffer (5190-0403) 

 25 x Fragmentation Buffer (5185-5974) 

 10 x Blocking Agents (5188-5281) 

アジレント Gene Expression Wash 

Gene Expression 洗浄バッファ 1 4L （5188-5325） 

Gene Expression 洗浄バッファ 2 4L （5188-5326） 

アジレント Gene Expression Wash Pack 

Gene Expression 洗浄バッファ 1 （5188-5325） が 2 個、Gene Expression 洗浄バッファ 2 

（5188-5326）が 1 個および TritonX-102 (1.35mL のチューブ 6 本) のセットです。 

アジレント Stabilization and Drying Solution  -  500 mL 

（製品番号 5185-5979） 

必要なソフトウェア 

１x244K、2x105K、4x44K フォーマットのアレイの解析のためには下記ソフトウェアが必須です 

 アジレントスキャナをご使用の場合、スキャンコントロールソフトウェア version A.7.0.1 以降 

 数値化ソフト Feature Extraction ソフトウェア version 9.1 以降 

8x15K フォーマットのアレイの解析のためには下記ソフトウェアが必須です 

 アジレントスキャナをご使用の場合、スキャンコントロールソフトウェア version A.7.0.1 以降 

 数値化ソフト Feature Extraction ソフトウェア version 9.5 以降 
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アジレント オリゴ DNA マイクロアレイ 

 

244K フォーマットのアレイは、 

１枚のスライドグラスに１枚のアレイが載っています。 

 

 

 

244K フォーマットのアレイ 

 

2x105K フォーマットのアレイは、 

1 枚のスライドグラスに 2 枚のアレイが載っています。 

 

 

 

 2x105K フォーマットのアレイ 

 

4x44K フォーマットのアレイは、 

１枚のスライドグラスに 4 枚のアレイが載っています。 

 

4x44K フォーマットのアレイ 

 

8x15K フォーマットのアレイは、 

1 枚のスライドグラスに 8 枚のアレイが載っています。 

 

 

 

8x15K フォーマットのアレイ 

 

オリゴ DNA マイクロアレイキット中には、アレイのレイアウトとアノテーション情報が記載された

CD-ROM、及び実験プロトコルが添付されています。 

 

※ アレイは室温で保存して下さい。フォイル開封後は暗所・室温で、真空デシケーター中か、窒素 

パージした箱の中で保管して下さい。開封後は、マイクロアレイスライドを外気にさらさないで下さい。 
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3．実験に必要な試薬の確認 
 

アジレント 遺伝子発現実験に必要なものリスト 
 

※ 指定 ： 必ず指定されたものをご使用ください。指定品以外を使用された場合は保証の対象外になります。 
※ 推奨 ： 安定した結果を得るために、推奨品の使用をお奨めします。推奨品以外の製品を使用された場合、 

アプリケーションサポートの対象外になります。 
※ 相当 ： コメント欄に記載された条件を満たすものなら、何を使用されてもかまいません。 

用途 品名　（アレイフォーマット） 製造メーカー 品番
指定/
推奨/
相当品

必要量 備考

アレイ Whole Human Genome (4x44K) Agilent G4110F － 4アレイ X 2スライドグラスで１キット

アレイ Whole Human Genome (4x44K) Agilent G4112F － 4アレイ X 5スライドグラスで１キット

アレイ Whole Mouse Genome (4x44K) Agilent G4121F － 4アレイ X 2スライドグラスで１キット

アレイ Whole Mouse Genome (4x44K) Agilent G4122F － 4アレイ X 5スライドグラスで１キット

アレイ Whole Rat Genome (4x44K) Agilent G4130F － 4アレイ X 2スライドグラスで１キット

アレイ Whole Rat Genome (4x44K) Agilent G4131F － 4アレイ X 5スライドグラスで１キット

アレイ Chicken (Gallus) (4x44K) Agilent G2519F015068 －

アレイ Magnaporthe II (4x44K) Agilent G2519F015060 －

アレイ Mouse Development (4x44K) Agilent G2519F015062 －

アレイ Rhesus Monkey (4x44K) Agilent G2519F015421 －

アレイ Gallus gallus(4x44K) Agilent G2519F015068 －

アレイ Yeast (4x44K) Agilent G2519F015072 －

アレイ Xenopus laevis (4x44K) Agilent G2519F015066 －

アレイ Rice  RAP-DB(4x44K) Agilent G2519F015241 －

アレイ Bovine (4x44K) Agilent G2519F015354 －

アレイ Soybean(4x44K) Agilent G2519F016047 －

アレイ Drosophila(4x44K) Agilent G2519F021791 －

アレイ Zebrafish(Danio rerio) (4x44K) Agilent G2519F019161 －

アレイ O.aries(8x15K) Agilent G4813A019921 －

アレイ S.Salar(4x44K) Agilent G2519F020938 －

アレイ Porcine ver.2(4x44K) Agilent G2519F020109 －

アレイ C. elegans (4x44K) Agilent G2519F020186 －

アレイ A.gambiae(4x44K) Agilent G2519F020449 －

アレイ O.cuniculus (4x44K) Agilent G2519F020908 －

アレイ N.tabacum(4x44K) Agilent G2519F021113 －

アレイ Arabidopsis ver.4 （4x44K) Agilent G2519F021169 －

アレイ Canine ver.2(4x44K) Agilent G2519F021193 －

アレイ E.caballus(4x44K) Agilent G2519F021322 －

アレイ Barley(4x44K) Agilent G2519F021623 －

アレイ Tomato(4x44K) Agilent G2519F022270 －

アレイ Wheat(4x44K) Agilent G2519F022297 －

アレイ Brassica(4x44K) Agilent G2519F022520 －

アレイ Cotton(4x44K) Agilent G2519F022523 －

アレイ Medicago(4x44K) Agilent G2519F022524 －

アレイ Custom Microarray Agilent － カスタムアレイ

ラベル化
Quick Amp Labeling Kit, One-

Color
Agilent 5190-0442 指定 1反応/アレイ

20反応分(Cyanine3-CTPが20反応
分含まれます)

ラベル化 Quick Amp Labeling Kit, two-color Agilent
5190-0444

指定 ２反応/アレイ
20反応分(Cyanine3-CTPが10反応
分、Cyanine5-CTPが10反応分含ま
れます)

ラベル化 Agilent One Color Spike Mix Kit Agilent 5188-5282 指定 1色法用のスパイクイン

ラベル化 Tow-Color Spike-In Kit Agilent 5188-5279 指定 2色法用のスパイクイン

ラベル化 Qiagen RNeasy mini kit Qiagen 74104 推奨

50精製分,１ラベル化反応に

１本使用します。２５０本入り
は　74106です。

ラベル化
エタノール (95-100%),
Molecular biology grade

相当
分子生物学実験に用いる純度の高
いエタノールを準備してください。

ラベル化＆
ハイブリ

DNase/RNase-free Distilled

Water 500mL
Invitrogen 10977-015 推奨 適量
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＊ Cyanine 3-CTP は、使用するまで-20℃以下での保存を推奨しております。凍結融解の繰り返しを避

けるために、開封後は 4℃、遮光状態で保管してください。 

 

＊ ハイブリダイゼーションバッファはマイクロアレイキットおよびラベル化キットには含まれておりません

ので、必ずアジレント Gene Expression Hybridization Kit をお求めください。 

 

アレイは室温で保存して下さい。フォイル開封後は暗所・室温で、真空デシケーター中か、窒素パージし

た箱の中で保管して下さい。開封後は、マイクロアレイスライドを外気にさらさないで下さい。 

用途 品名　（アレイフォーマット） 製造メーカー 品番
指定/
推奨/
相当品

必要量 備考

ラベル化
エタノール (95-100%),
Molecular biology grade

相当
分子生物学実験に用いる純度の高
いエタノールを準備してください。

ラベル化＆
ハイブリ

DNase/RNase-free Distilled

Water 500mL
Invitrogen 10977-015 推奨 適量

ハイブリ Gene Expression Hybridization Kit Agilent 5188-5242 指定

20アレイ分（2x105K）

または10アレイ分(244K)

または45アレイ分（4X44K)

または100アレイ分(8x15K)

ハイブリ
Hi-RPM Gene Expression

Hybridization Kit (Large volume)
Agilent 5190-0404 指定

200アレイ分（2x105K）

または100アレイ分(244K)

または450アレイ分(4x44K)

または1000アレイ分(8x15K)

ハイブリ
2 x Hi-RPM Hybridization Buffer

(25ml)
Agilent 5190-0403 指定 5190-0404に含まれています。

ハイブリ 25 x Fragmentation Buffer (10ml) Agilent 5185-5974 指定 5190-0404に含まれています。

ハイブリ 10 x Blocking Agents Agilent 5188-5281 指定 5190-0404に含まれています。

ハイブリ MilliQ水 推奨

洗浄
Gene Expression Wash Buffer 1

(4L)
Agilent 5188-5325 指定 500 mL程度

洗浄
Gene Expression Wash Buffer 2

(4L)
Agilent 5188-5326 指定 250 mL程度

洗浄 Gene Expression Wash Pack Agilent 5188-5327 指定
5188-5325が2個5188-5326が1個と

Triton X-102(1.35 mL 6本)のセット

洗浄 10% Triton X-102 (50mL) Agilent 5185-5975 指定
GE Wash Packをご購入の場合は添

付で納品されます

洗浄
Stabilization and Drying Solution

(500ml)
Agilent 5185-5979 推奨 250ml程度；

実験室に高濃度のオゾンが存在する
場合のみ必要。オゾンフリーブースが
設置してある場合は必要ありません。

洗浄 Acetonitrile, anhydrous 99.8%, 1 L Sigma-Aldrich 271004 推奨 250ml程度
2色法でStabilization and Drying

solutionを使う際は、必要です。
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4．実験に必要な機器・器具 

 

 

用途 品名　（アレイフォーマット） 製造メーカー 品番
指定/
推奨/
相当品

必要量 備考

ラベル化 50mlコニカルチューブ（滅菌） 相当

ラベル化 ピペットチップ 相当
RNase Freeの物をお使いください。

オートクレーブ処理はお勧めしません。

ラベル化 UV分光光度計 NanoDrop ND-1000 相当

ラベル化 卓上遠心器 日本ミリポア チビタンII 相当

ラベル化＆
ハイブリ

パウダーフリー手袋
SAFE SKIN グローブ
PRE (S, M, L サイズ)

Kimberly・Clark
220, 330, 440

(S, M, Lサイズ)
相当

ラベル化＆
ハイブリ

ピペット（1ul-1ml) 相当

ラベル化＆
ハイブリ

1.5mlエッペンチューブ 相当
RNase Freeの物をお使いください。

オートクレーブ処理はお勧めしません。

ラベル化＆
ハイブリ

ヒートブロック（ラベル化65℃，

70℃）
ｴｯﾍﾟﾝﾄﾞﾙﾌ

ｻｰﾓﾐｷｻｰｺﾝﾌｫｰﾄ
5355-000-011

相当

ラベル化＆
ハイブリ

ウォータバス
（ラベル化４0℃、断片化60℃）

相当

ラベル化＆
ハイブリ

アイスバケツ

ラベル化＆
ハイブリ

高速遠心機 相当

ラベル化＆
ハイブリ

ボルテックスミキサー 相当

ハイブリ
オリゴDNAマイクロアレイ用
ハイブリダイゼーションチャンバ

Agilent G2534A 指定 消耗品が別途必要です。

ハイブリ
244K フォーマット用消耗品

(ガスケットスライド)
Agilent G2534-60003 指定 5枚セット

ハイブリ
244K フォーマット用消耗品

(ガスケットスライド)
Agilent G2534-60008 指定 20枚セット

ハイブリ
244K フォーマット用消耗品

(ガスケットスライド)
Agilent G2534-60005 指定 100枚セット

ハイブリ
2x105Kフォーマット用消耗品

(ガスケットスライド)
Agilent G2534-60002 指定 5枚セット

ハイブリ
2x105Kフォーマット用消耗品

(ガスケットスライド)
Agilent G2534-60009 指定 20枚セット

ハイブリ
2x105Kフォーマット用消耗品

(ガスケットスライド)
Agilent G2534-60006 指定 100枚セット

ハイブリ
4x44Kフォーマット用消耗品

（ガスケットスライド）
Agilent G2534-60011 指定 5枚セット

ハイブリ
4x44Kフォーマット用消耗品

（ガスケットスライド）
Agilent G2534-60012 指定 20枚セット

ハイブリ
4x44Kフォーマット用消耗品

（ガスケットスライド）
Agilent G2534-60013 指定 100枚セット

ハイブリ
8x15Kフォーマット用消耗品

（ガスケットスライド）
Agilent G2534-60014 指定 5枚セット

ハイブリ
8x15Kフォーマット用消耗品

（ガスケットスライド）
Agilent G2534-60015 指定 20枚セット

ハイブリ
8x15Kフォーマット用消耗品

（ガスケットスライド）
Agilent G2534-60016 指定 100枚セット

ハイブリ ハイブリダイゼーションオーブン Agilent G2545A 指定 1台
別途専用ローターが必要です。
（下記）

ハイブリ
ハイブリダイゼーションオーブン
ローター

Agilent G2530-60029 指定 1個
最大24チャンバーまで載せることができ

ます。

ハイブリ ハイブリエイド
アジレントにお問
い合わせください

HYB-100 1セット

オプションとして使用できます。ハイブリ
ダイゼーションの際、マイクロアレイスラ
イドをガスケットスライドに乗せる作業を
補助する器具です。ハイブリダイゼーショ
ン作業を安定して行うことが出来ます。
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用途 品名 製造メーカー 品番

指定/推

奨/相当

品

必要量 備考

洗浄
クリーンガード
ブルーニトリルグローブ

Kimberly・Clark

57371,

57372,

57373

 (S, M, Lサイズ）

相当

事前にビーカーに入れたWash buffer1
で手袋を洗い、手袋から垂れるbufferが
白濁していないこと、ビーカー内のbuffer
に微粒子がないことを確認してください。
二トリルグローブと超精密ピンセット33A
のどちらかをアレイの洗浄ステップで使
用することをお勧めします。

洗浄 密閉容器 相当 1個
洗浄バッファ2を37℃に保温するのに使
います。

洗浄
スライド洗浄ガラス容器（Dish)（中 ）
Pyrex容器でも可

Wheaton 900301 相当
１個
(1セット3個入りです)

ガスケットスライドとマイクロアレイスライ
ドを解体するときに使います。
Wheaton900201やPyrexも使用可能で
すが、作業しやすくするため、
Weaton900201や小さい容器を使う場合
は超精密ピンセット33Aも合わせて使用
することをお勧めします。

洗浄 スライドラック　小　(ステンレス製)
Thermo

Shandon
109 相当 １個

ガラス容器900201（Wheaton）または
102（Thermo Shandon)を使用してくださ
い。最大洗浄枚数は5枚です。

洗浄 スライド洗浄ガラス容器（Dish)（小 ） Wheaton 900201 相当
2個あるいは4個

(1セット3個入りです)

スライドラック109（Thermo Shandon)に
対応しています。Wash buffer1, 2 (およ
びアセトニトリル, S&D溶液)に各1個ずつ
使用します。

洗浄 スライド洗浄ガラス容器（Dish)
Thermo

Shandon
102 相当

2個あるいは4個
（１個単位での販売で
す）

スライドラック109（Thermo Shandon)に
対応しています。Wash buffer1, 2 (およ
びアセトニトリル, S&D溶液)に各1個ずつ
使用します。

洗浄 スライドラック　中　(ステンレス製)
Thermo

Shandon
113 相当 1個

ガラス容器122に対応するサイズです。
最大洗浄枚数は8枚です。

洗浄 スライド洗浄ガラス容器（Dish)　(中）
Thermo

Shandon
122 相当

2個あるいは4個
（１個単位での販売で
す）

スライドラックは113(Thermoshandon)を
使用してください。 Wash buffer1, 2 (お
よびアセトニトリル, S&D溶液)に各1個ず
つ使用します。

洗浄 スターラー 相当 1台または2台

洗浄 恒温槽付スターラー 相当 1台

洗浄 回転子 相当 2個あるいは4個
小Dishには3cm、大Dishには4.5cm程

度のもの

洗浄 漏斗 相当 １個

洗浄
500mLの褐色または透明なガラス
瓶

相当 １個

洗浄 フラットピンセット 33A アズワン 7-160-13 相当 2個
マイクロアレイの洗浄ステップで二トリル
グローブと超精密ピンセット33Aのどちら
かを使用することをお勧めします。

洗浄
および

スキャン
オゾンフリーブース アズワン 2-M005-01B 推奨 1台

洗浄およびスキャン時のオゾンによる蛍
光色素の褪色を防ぎます。2色法の実験
には必須です。

スキャン
ウェハーガードGNガスフィルターガ
ン

日本インテグリス
株式会社

WGGB01KAG 推奨 1台

窒素ガスボンベに装着して使用します。
スライドガラスに付着したほこりを除く(ブ
ロワーで代用可能)、あるいは窒素パー
ジしてスライドグラスを保存する際に使
用します。フィルターガンのほかに、フィ
ルターおよびスパイラルチューブが必要
です。

スキャン オゾンバリアカバー Agilent G2505-60550 推奨

スキャン時のオゾンによる蛍光色素の
褪色を軽減します。アジレントアレイおよ
びアジレントスキャナの組み合わせで使
用可能です。

アレイの保存 スーパードライ　小型 SAYNSYO
59-0090

(2段タイプ)
相当 1台

パッケージ開封後のマイクロアレイや使
用済みのマイクロアレイの保存用デシ
ケータです。1段タイプ(59-0089)もありま
す。

スターラーおよび恒温槽付スターラーが
1台ずつ必要です。恒温槽付スターラー

がない場合は、スターラーは2台必要で

す。

アセトニトリルおよび S&D溶液は数回

繰り返し使うことが出来ます。使用済み
のアセトニトリルおよびS&D溶液を保存

するために使用します。

《参考商品》

《スライドグラス解体用》

《一回の洗浄が5枚以下の場合：必要なものを組み合わせて購入ください》

《一回の洗浄が8枚以下の場合：必要なものを組み合わせて購入ください》

《その他洗浄に必要な器具》



 オリゴ DNA マイクロアレイキット 2 色法プロトコル操作実習テキスト 

 

14 

＊ 洗浄用ガラス容器の必要数について 

１色法ではスライド解体用に 1 個、Wash1 と 2 用に各 1 個ずつ（解体用含めて計 3 個）、2 色法で S&D

溶液を使用する場合は、アセトニトリル用も含めさらに 2 個(解体用含めて計 5 個)必要です。 

＊ 洗浄用ガラス容器のサイズについて 

１回の洗浄がスライドグラス５枚以下なら小、５から８枚なら中を選択します。 

 

【試薬・消耗品の保証期間について】 

 アジレントマイクロアレイおよびその他のアジレント製品の保証期間は、箱やチューブの入った

小袋あるいはボトルに記載の Expiration date(Exp. date)までです。保証期間を過ぎた製品に

ついては欠品等があった場合も交換ができない場合がありますので、製品が納品されたらすぐ

に内容物を確認して下さい。 

 保証期間を過ぎると性能の保証ができないため、保証期間内に使用するように計画して下さい。 
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5．実習を始める前に 

 

 弊社内では、来客用プレートを着用いただきますよう、お願い申し上げます。 

また実験室内では、ネームプレートを着用いただきますよう、お願い申し上げます。 

 実験室内では、飲食、タバコは禁止されております。 

 応接室にあるコーヒー等はご自由にご利用ください。 

 喫煙は、喫煙コーナーでお願いいたします。 

 携帯電話は、他のお客様のご迷惑にならないようにご使用ください。 

（原則、マナーモードでのご使用をお願い致します） 

 

 実験室内では必ず白衣、手袋、必要に応じてマスク、眼鏡をご着用ください。 

 スライドグラスの縁は鋭利です。手袋をはめ、十分注意して取り扱ってください。 

 本実験では、毒性のある試薬を使用します。弊社でも留意しておりますが、操作時の安全には、

各自で十分ご注意いただきますよう、お願い申し上げます。 

 毒性のある溶液に触れたチップやチューブの廃棄場所は、弊社担当者にご確認ください。 

 Cyanine 3-CTP と Cyanine 5-CTP は発癌性物質を含んでいます。吸引、誤飲、皮膚への直接

の接触は避けてください。 

 RNase のコンタミネーションを防ぐために、実験中はパウダーフリーの手袋を着用し、ヌクレアー

ゼフリーの溶液およびピペットチップを使用してください。 

 Cyanine 3-CTP と Cyanine 5-CTP は光で分解します。出来る限り光にあたらないように注意し

て使用してください。保管時，反応時は必ず遮光してください。 

 本キット中のハイブリダイゼーションバッファには塩化リチウム(LiCl)が含まれています。 

塩化リチウム(LiCl)には中枢神経系への毒性があります。 

催奇性があり、乳児に悪影響を与える可能性があります。 

不妊を誘発する可能性があります。 

吸入、皮膚接触、誤飲により、害を引き起こします。必ず適切な白衣、手袋、マスク、防護めがね

等を着用してください。 

 ハイブリダイゼーションバッファにはラウリル硫酸リチウム(LLS)が含まれています。 

ラウリル硫酸リチウム(LLS)は毒性があり、目、気管器系、皮膚に炎症を起こす可能性があります。

必ず適切な白衣、手袋、マスク、防護めがね等を着用してください。 

 Agilent Stabilization and Drying Solution (cat. No. 5185-5979)は、毒性、引火性があります。

必ず、適切なヒュームフード（ドラフト）内で使用して下さい。 

 Agilent Stabilization and Drying Solution (cat. No. 5185-5979)は有機溶媒を含んでいます。

HPLC 廃液およびフェノール廃液と同様な廃棄処理を行ってください。 

 実験に使用する全ての試薬・消耗品のロット番号と Expiration Date を記録して下さい。お

問い合わせ頂く際はこれらの情報を添えて、お問い合わせ下さい。 
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6．実習の概要 

 

 本日の実習はオリゴ DNA マイクロアレイを 4 サンプルで１枚ご使用いただきます。 

 １名で１種類の total RNA サンプルをラベル化していただきます。 

 サンプルはそれぞれ 500ng 使用します。 

 ご自分のサンプルが決まったら、ノートに明記いただくようお願いいたします。 

予備のアレイ、サンプルは準備されておりません。なにとぞご了解ください。 

 

 

 ご自分のサンプル           ,  Cy-         

                   

 ペアの方のサンプル          ,  Cy-          
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プロトコールの全体図 
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実験のタイムテーブル 

 

Step Temperature Time 

cDNA合成 155 min 

プライマーとテンプレートの熱変性 65ºC 10 min 

急冷 氷上 5 min 

二本鎖cDNA合成 40ºC 120 min 

逆転写酵素の失活 65ºC 15 min 

急冷 氷上 5 min 

cRNA合成 120 min 

cRNA合成 40ºC 120 min 

cRNA精製 30 min 

cRNA精製 RT 30 min 
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7．１日目：実験の前準備 

 机の上に、以下のものがあるかどうかをご確認ください。 

 マイクロピペッター（RNA 用） 1-10uL,10-100uL,100-1000uL の３本 

 ピペットチップ（RNA 用） 上記各サイズ対応 

 チューブ立て 

 1.5mL チューブ（RNaseFree） 各自２本 

 アイスボックス（中にラベル化キットの試薬チューブと Cy-3,Cy-5 が入っています。

Cy-3,Cy-5 にはアルミフォイルをかぶせて遮光しておきます。） 

※ 反応には、Cyanine 3-CTP (10mM) および Cyanine 5-CTP (10mM) を各 2.4 uL ずつ

使用します。事前に反応数を確認し、十分な Cyanine Dye が手元にあるようにします。 

 ヌクレアーゼフリー水 

 96-100％ エタノール 

 タイマー 

 Vortex ミキサー 

 パーソナル遠心機 

 油性ペン 

 あらかじめ使用する機器の温度設定をしておきます。 

 ウォーターバスを 37℃、40℃に設定。cRNA 増幅＆ラベル化反応後 60℃に設定 

 ヒーティングブロックを 65℃、80℃に設定 

 37℃
Spike-Mixの溶解 (5min)

65℃
T7 Promoter Primer の
アニーリング (10min)

40℃
cDNA合成反応 (2hr)

PEGの溶解 (1min)

40℃
ラベル化cRNA合成反応 (2hr)

65℃ または 70℃
熱変性 (65℃ 4分 または 70℃ 2分)

80℃
5X First Strand Bufferの溶解 (3 - 4min)

65℃
cDNA合成反応停止 (15min)

60℃
フラグメンテーション反応 (30min)

8-2. cDNA 合成反応（２ｈｒ）

8-3. cRNA 増幅＆ラベル化（２ｈｒ）

8-2. RNA テンプレートへの
T7 Promoter Primer のアニーリング

8-1. Spike-Mix の調製

8-4. Cyanine3-ラベル化 cRNA の精製

(8-5. バイオアナライザによる
ラベル化cRNAの品質チェック）

8-9-2. ハイブリダイゼーションの準備

（フラグメンテーション）

37℃
Spike-Mixの溶解 (5min)

65℃
T7 Promoter Primer の
アニーリング (10min)

40℃
cDNA合成反応 (2hr)

PEGの溶解 (1min)

40℃
ラベル化cRNA合成反応 (2hr)

65℃ または 70℃
熱変性 (65℃ 4分 または 70℃ 2分)

80℃
5X First Strand Bufferの溶解 (3 - 4min)

65℃
cDNA合成反応停止 (15min)

60℃
フラグメンテーション反応 (30min)

8-2. cDNA 合成反応（２ｈｒ）

8-3. cRNA 増幅＆ラベル化（２ｈｒ）

8-2. RNA テンプレートへの
T7 Promoter Primer のアニーリング

8-1. Spike-Mix の調製

8-4. Cyanine3-ラベル化 cRNA の精製

(8-5. バイオアナライザによる
ラベル化cRNAの品質チェック）

8-9-2. ハイブリダイゼーションの準備

（フラグメンテーション）
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8．実験：１日目（必ずプロトコールを参照ください。） 

 

8-1. RNA Spike A および B Mix の調製（オプション） 

ラベル化に用いる出発 RNA 量によって、RNA Spike A および B Mix の希釈率が変わります。 

実験に使用するトータル RNA は、    ng です。下記の表を参照すると、今回の希釈手順は、それぞれ、

以下の通りになります。 

 

※ 37℃、5 分間の加温を行ない、Spike A あるいは Spike B Mix （原液）を溶かします。ボルテックスで

混合し、スピンダウンしてチューブの蓋、壁に付いた液を集めます。 

 

1st : 2uL の Spike A あるいは Spike B Mix に 38uL の Dilution Buffer を加えます（1:20） 

・ボルテックスで混合し、スピンダウンしてチューブの蓋、壁に付いた液を集めます。 

2nd : 2uL の 1st 希釈液（Spike A あるいは Spike B）に 78uL の Dilution Buffer を加えます（1:40） 

・ボルテックスで混合し、スピンダウンしてチューブの蓋、壁に付いた液を集めます。 

3rd : 2uL の 2nd 希釈液（Spike A あるいは Spike B）に    uL の Dilution Buffer を加えます（1:    ） 

・ボルテックスで混合し、スピンダウンしてチューブの蓋、壁に付いた液を集めます。 

 

出発 RNA 量 希釈手順 3rd SpikeA あるいは 3rd SpikeB の必要量(uL) 

トータル RNA (ng)  PolyA RNA (ng)  1st  2nd 3rd  

50-200 1:20 1:40 1:16 2 

201-2000 1:20 1:40 1:4 2 

>2000 200 1:20 1:40 2 

 

重要 Spike A は Cy-3 でラベル化するサンプルに、Spike B は Cy-5 でラベル化するサンプルに加え

ます。絶対に間違いの無いようにして下さい。 

 

注意 Spike-in量の精度を確保するため、Spike-Mix を調製する場合は、2 uL以上の量を扱うように

してください。 

 

※ 調製した 1st希釈液は、‐70 ～‐80℃で約 2 ヶ月まで保存できます。さらに、8回までの凍結融解を

繰り返すことが可能です。2ndおよび 3rd希釈液は保存、再利用できないので実験の都度作成します。 

 

 

本実習では、Spike-in Control を用います。 
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8-2.トータル RNA からの cDNA 合成 

 

実験に使用する total RNA は、    ng/uL の濃度です。    ng のトータル RNA から 

出発する場合は、サンプル量は    uL になります。 

本ラベル化キットは 50 ng から 5,000 ng のトータル RNA にお使いいただけますが、最適な性能を発揮

するために 500 – 1,000 ng のトータル RNA をラベル化反応に用いることを推奨いたします。

PolyA+RNA から出発する場合は、10ng-200ng の範囲の PolyA+RNA をお使いください。 

 

 反応チューブにサンプル名と色素名を書いてください。 

 必要な RNA 量と水の量は、RNA サンプルの濃度により異なりますのでご注意下さい。 

 

 

※ Spike A 液を Cy3 でラベル化するサンプルに、 

Spike B 液を Cy5 でラベル化するサンプルに間違えないように加えてください。 

 

 

 

 

 

 ６５℃で１０分 インキュベーション （熱変性） 

 氷で急冷、そのまま５分間冷却 

 

※ ここで使用する水は、必ず、Invitrogen 社の DNase/RNase-free water (10977015)をお使いください。

DEPC 処理水を使用した場合、この後の反応を阻害する恐れがあります。 

 

 

 

Totalで11.5 ul になるように調製します。

Total RNA ___ul

T7 Promoterプライマー 1.2 ul

調製済みSpike-in Control 　2 ul

Nuclease Free Water ___ul

Totalで11.5 ul になるように調製します。

Total RNA ___ul

T7 Promoterプライマー 1.2 ul

調製済みSpike-in Control 　2 ul

Nuclease Free Water ___ul
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一反応分の
必要量(uL)

2.2反応分
(uL)

　5x First Strand Buffer(Pre-Warm, 80℃) 4 8.8
　0.1M DTT 2 4.4
　10mM dNTP mix 1 2.2
　MMLV-RT(反応開始直前に加える) 1 2.2
　RNase Inhibitor(反応開始直前に加える） 0.5 1.1
　トータル量 8.5 18.7

この待ち時間に、cDNA マスターミックスを作成します。通常の実験では必要量をまとめて調製しますが、

今回は実習のため、お二人ずつ作成していただきます（2.2 反応分作成します）。 

ただし、MMLV-RT と RNase Inhibitor は反応開始直前まで加えないでください。 

 

注意 5X First Strand Buffer は使用前に80℃のウォーターバスで３－4分間温めます。ボルテック

スでよく混合し、スピンダウンしてチューブの蓋、壁に付いた液を集めます。使用するまで室

温で置いておきます（氷上に置くと析出する場合があります）。 

 

 

 

反応開始直前に MMLV-RT と RNase Inhibitor を加えることを忘れないようにしてください。 

cDNA マスターミックスは使用するまで室温に置いておきます。 

 

 各反応チューブ（RNA サンプルが入ったチューブ）に 8.5 uL の cDNA ミックスを加えます。ピペッ

ティングで溶液を混合します。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 ４０℃のウオーターバスで、２時間インキュベーションします。 

 

 

 

 

 

cDNA合成反応

ミックス

8.5 ul

cDNA合成反応

ミックス

8.5 ul
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一反応分の
必要量(uL)

2.2反応分
(uL)

　Nuclease-free water 15.3 33.66

　4x Transcription Buffer 20 44

　0.1M DTT 6 13.2

　NTP mix 8 17.6

　50% PEG (Pre-warm, 40℃) 6.4 14.08

　RＮase Inhibitor(反応開始直前に加える) 0.5 1.1

　Inorganic Pyrophosphatase(反応開始直前に加える) 0.6 1.32

　T7 RNA Polymerase(反応開始直前に加える) 0.8 1.76

  Cyanine 3 or 5 -CTP(反応開始直前に加える) 2.4 5.28

　トータル量 60 132

8-3．Cyanine3-/Cyanine5-ラベル化 cRNA の合成 

 

チューブをウォーターバスから取り出し、65℃15 分間インキュベーションし、反応を停止します。 

 チューブを氷で急冷し、5 分間冷却します。 

 

 

この待ち時間に、Transcription マスターミックスを作成します。ただし、酵素および色素は反応を開始

する直前まで混合しないで下さい。 また、通常の実験では必要量をまとめて調製しますが、今回は実

習のため、お二人ずつ作成していただきます（2.2 反応分作成します）。 

 

注意 使用前に50% PEGを40℃のウォーターバスで1分間温めます。ボルテックスでよく混合し、

スピンダウンしてチューブの蓋や壁についた液を集めます。使用するまで室温で置いておき

ます。 

 

注意 Cy3-CTP用およびCy5-CTP用のマスターミックスをそれぞれ調整します。 

 

各マスターミックスは、使用するまで室温に置いておきます。 

各 Transcription マスターミックスチューブに、Cyanine 3-CTP (10mM) または Cyanine 5-CTP 

(10mM) のどちらか一方を加えます。スキャン後の蛍光の色と、色素自身の色が異なりますので、

十分に注意してください。 

 

 

 色素が光にさらされる時間を極力短くしてください。  
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 各反応チューブに、60uL の Transcription ミックスを加えます。酵素を最後に入れるのを、忘れ

ないようにしてください。 

 

 

 

 

 

 

 

 ４０℃のウオーターバスで、２時間インキュベーションします。 

 チューブにアルミフォイルをかぶせ、遮光することをお奨めします。 

 

 

 

 

 

 

 

 

 

 

 

Cy3Cy3 Cy5Cy5

アルミフォイルで遮光アルミフォイルで遮光

Cy3Cy3

60 ul

Cyanine3

Transcription
mix

Cy3Cy3Cy3Cy3Cy3

60 ul

Cyanine3

Transcription
mix

Cy3Cy3

60 ul

Cyanine5 

Transcription
mix

Cy3Cy3Cy3Cy3Cy3

60 ul

Cyanine5 

Transcription
mix
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8-4．Cyanine3-/Cyanine5-ラベル化 cRNA の精製 

 本プロトコルではQiagenのRNeasyを使ってラベル化cRNAを精製することを推奨しています。ラ

ベル化の際に取り込まれなかったラベル化ヌクレオチド（モノマー）が、ハイブリダイゼーション液

中に存在すると、マイクロアレイのバックグランドの蛍光が著しく高くなります。以下に記載してあ

るRNeasy mini のプロトコルに従って実験を進めてください（Qiagenのプロトコルを一部変更して

あります。必ず本プロトコルを参照ください）。 

 使用前に RPE バッファに、エタノール（96-100%）を必要量加えてください（実習で使用する PRE

バッファは調製済みですが、念のためにバッファのフタのラベルの ethanol の項目にチェックマー

クが入っているかを確認してください。RPE バッファは次の頁の洗浄ステップで使用します）。 

 全ての遠心のステップは、13,000rpm(10,000g)以上の回転数で行ってください。 

遠心を4℃で行うことにより、cRNA の収率があがること確認されております。以下の遠心のステッ

プで、遠心機を 4℃に設定することを強くお奨めいたします。 

 RLTバッファにβ-メルカプトエタノール(β-ME)を加える必要はありません（β-MEが入っていても 

問題ありません）。 

 

1. 20 µLのヌクレアーゼフリー水をcRNAに加え、液量を100 µLにします。 

 

 

 

 

 

 

 

2． 350 µLのRLTバッファを加え、混合します。 

3． 250 µLのエタノール（96-100%）を加え、ピペットで混合します。スピンダウンを含め遠心はしないで

下さい。 

4． 700 µLのcRNAサンプルを2 mLのコレクションチューブをつけたRNeasy miniカラムに移します。カ

ラムチューブを13,000 rpmで30秒間遠心します。カラムを素通りした液は捨てます。 
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5． RNeasyカラムを新しいコレクションチューブに移し、500 µLの調製済みのRPEバッファ（エタノール

が加えられたもの）をカラムに加えます。カラムチューブを13,000 rpmで30秒間遠心します。カラム

を素通りした液は捨てます。 

 

 

 

 

 

 

 

 

 

 

コレクションチューブはそのまま使用し、再度500 µLのRPEバッファをカラムに加えます。カラムチュ

ーブを13,000 rpmで1分間遠心します。カラムを素通りした液は捨てます。 

もしカラムのフリットにRPEバッファが残っていれば、カラムを新しい1.5mLチューブに移し、13,000 

rpmで1分間遠心し、残っているRPEバッファを完全に取り除きます 

 

6． RNeasyカラムを新しい1.5 mLのコレクションチューブに移します。 

 

 

 

 

 

 

 

 

 

30 µL のRNase-free水をカラムのフィルターに加え、1分間おきます。カラムチューブを13,000 rpm

で30秒間遠心します。カラムを通った液はそのまま残します（液を捨てないように注意してください）。 

カラムを通った液量は約30 µLになります。使用済みのカラムは捨てます。できあがったｃRNA 

濃度、収量および品質をUV計とバイオアナライザを用いてチェックします（次ページ参照）。 

 

7． この操作の終了後、ハイブリダーゼーションを引き続き行う場合には、以下の設定をしておきます。 

(ア) ウォーターバスまたはヒートブロックを 60℃に設定 

(イ) ハイブリダーゼーションオーブンを 65℃に設定（ローターを取り付けておきます） 
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8-5．ラベル化 cRNA の分析 

【NanoDropによる評価】 

通常500 ngのトータルRNAからスタートした場合、2.0 – 4.0 ugのcRNAを合成できますが、トータルRNA

の純度や質(分解度)によっても異なります。合成したcRNA量は、通常のキュベットを使った分光光度

計で測定するには少なすぎる場合がほとんどです。濃度決定に使用するRNA量を最小限に抑えるた

めに、本プロトコルではNanoDrop分光光度計を推奨しています。 

 NanoDropのソフトウェアを起動し、”Microarray Measurement”のタブを選択します。 

 1 uLのヌクレアーゼフリー水で、NanoDropでブランクを設定します。 

 1 uLの増幅 (ラベル化) cRNAを測定し、A260とA550とA650を記録します。 

 

(1) NanoDrop 計測結果より、cRNA濃度 （ng/uL）を記録します。 

RNA濃度が自動算出されない分光光度計をご使用の場合、A260の値から以下の式で算出して下さい。 

cRNA conc. (ng/uL) * = A260 x 40 ug/mL x dilution factor** 

*光路長10 mmの測定器を使用した場合の式です。ご使用の機器の光路長をご確認下さい。 

**希釈せずに濃度を測定した場合は、Dilution Factorは1を用います。 

 

(2) (1)のcRNA濃度（ng/uL）に溶出量（ 使用した精製キットにより30 ul あるいは20 ul ） 

を乗じ、以下の式でcRNA収量を算出します。 

cRNA yield(ug) = cRNA conc(ng/uL) × 30(uL) / 1000  

 

(3) NanoDrop 計測結果より、CyDyeの濃度 (pmol/ul)を記録します。 

色素濃度が自動算出されない分光光度計をご使用の場合、A550 (Cy3)、A650(Cy5)の値から以下の式で算出し

て下さい。 

Cy3-CTP conc (pmol/ul) * = A550 x 1000 ÷ 150 mM-1cm-1 x dilution factor** 

Cy5-CTP conc (pmol/ul) * = A650 x 1000 ÷ 250 mM-1cm-1 x dilution factor** 

*光路長10 mmの測定器を使用した場合の式です。ご使用の機器の光路長をご確認下さい。 

**希釈せずに濃度を測定した場合は、Dilution Factorは1を用います。 

 

(4) 以下の式で、CyDyeの濃度と取込率を算出します。 

 

Cy3-CTP incorporation (ng/uL) = Cy3-CTP conc.(pmol/uL) ×1000 

cRNA conc. (ng/uL) 

 

Cy5-CTP incorporation (ng/uL) = Cy5-CTP conc.(pmol/uL) ×1000 

cRNA conc. (ng/uL) 
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※通常cRNAの溶出量は825ng以上、CyDyeの取り込み効率は8 pmol/ug以上が期待されます。それ

以下の場合には、再度cRNAの調製をされる事をお勧めいたします。 

 

 測定した濃度から、マイクロアレイへのハイブリダイゼーションに必要な cRNA 量を計算します。 

アレイフォーマットによって必要量が異なるのでご注意ください(P.27 参照)。 

 

【バイオアナライザによる評価】 

 1.5mL エッペンチューブに 1.5uL のラベル化 cRNA を移します。 熱変性（72℃2 分）を行い、氷

上に置きます。 1uL をバイオアナライザの測定に供します。 

 バイオアナライザでラベル化 cRNA を泳動する際は、mRNA assay を選択します。 

 バイオアナライザのエレクトロフェログラムから cRNA の質を確認します。 

 

 

バイオアナライザの分析例 

 

 

ラベル化サンプルのシグナルの大部分が、200 から 2000 塩基長のサイズ範囲に位置しているかを確認

して下さい。これ以外の領域にピークの大部分がある場合、正確なデータが出ない可能性があります。 

データ分析時に、ツールバーのアイコン をクリックすると、横軸の表示を秒あるいは nt に切り

替えられます。 

 

ラベル化 cRNA の保存 

cRNA を直ぐに使用しない場合には、少量に分注し、暗所－80℃で保存します。長期保存の場合は、チ

ューブに分注して保存して下さい。 

サンプルの冷凍、解凍のサイクルを繰り返すと cRNA が分解しやすくなります。保管している cRNA の質

がわからない時は、Agilent 2100 バイオアナライザおよび UV 計で質を再確認することをお勧めします。

F
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8-6．ハイブリダイゼーションの準備 

 

1． 増幅反応を行っている間に、ハイブリダイゼーションチャンバの組み立てと、ハイブリの練習を行い

ます。次のものを準備しますので、ご確認ください。 

(ウ) アジレント オリゴ DNA マイクロアレイ 練習用 （本実習ではお二人でスライドグラス１枚を使

用いただきます。アレイは２人で１枚使用します） 

(エ) 練習用の水（ハイブリダイゼーション溶液として練習に使用します） 

(オ) オリゴアレイ用 ハイブリダイゼーションチャンバ 

(カ) ピンセット（清潔なもの） 

(キ) パウダーフリー手袋  

(ク) マイクロピペッター（DNA 用または RNase 用） 1-10uL,10-100uL,100-1000uL の３本 

(ケ) ピペットチップ（DNA 用） 上記各サイズ対応 

(コ) 1.5 mL エッペンチューブ（滅菌済ヌクレアーゼフリー） 

(サ) チューブ立て（RNase 用） 

(シ) 高速遠心機 

(ス) ボルテックスミキサー 

(セ) アイスボックス 

(ソ) タイマー 

(タ) ヒートブロック、またはウォーターバス（60℃） 

(チ) ハイブリダイゼーションオーブン（65℃） 

(ツ) アジレントチャンバ用ハイブリダーゼーションローター 

 

2． 使用する機器の温度設定を確認しておきます。 

(テ) ウォーターバスまたはヒートブロックを 60℃に設定 （増幅反応終了後に変更します） 

(ト) ハイブリダーゼーションオーブンを 65℃に設定（ローターを取り付けておきます） 
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8-7．ハイブリダイゼーションチャンバの種類 

 

使用するアレイのフォーマットに合ったチャンバ消耗品を使用してください。 

244K のフォーマットの In-situ オリゴ DNA マイクロアレイは 1 アレイ/1 スライドですので、[G2534-60003] 

のガスケットスライドを使用します。 

2x105K フォーマットのマイクロアレイは 2 アレイ/1 スライドですので、[G2534-60002] のガスケットスラ

イドを使用します。 

4x44K フォーマットのマイクロアレイ（カタログアレイでは Human、Mouse、Rat、その他） は 4 アレイ/1

スライドですので、[G2534-60011] のガスケットスライドを使用します。 

8x15K フォーマットのマイクロアレイ は 8 アレイ/1 スライドですので、[G2534-60014] のガスケットスラ

イドを使用します。 

 

 

注意 本チャンバはアジレントのオリゴ DNA マイクロアレイ専用です。アジレントの cDNA マイクロ

アレイには使うことが出来ません。また他メーカーのアレイに使用することは出来ません（使

用を想定しておりません）のでご注意ください。 

 

 

 

 

 

 

ｱﾚｲ ﾌｫｰﾏｯﾄ 8x15K 4x44K 2x105K 244K

ﾊｲﾌ ﾘ゙ﾀ ｲ゙ｾ ﾞー ｼｮﾝ
液量 (1ｱﾚｲあたり）

40uL 100uL 245uL 490uL

ｶ ｽ゙ ｹｯﾄｽ ﾗｲﾄﾞ
G2534-60014

(8ｱﾚｲ
   x 5ｽﾗｲﾄ 分゙）

G2534-60011

(4ｱﾚｲ
   x 5ｽﾗｲﾄ 分゙）

G2534-60002

(2ｱﾚｲ
   x 5ｽﾗｲﾄ 分゙)

G2534-60003

(5ｽﾗｲﾄ 分゙)

ﾁｬﾝﾊ ﾞー

G2534A

ﾊｲﾌ ﾘ゙ﾀ ｲ゙ｾ ﾞー ｼｮﾝ
回転速度

(8x15K、4x44K、2x105K、244K)

10 rpm

ﾊｲﾌ ﾘ゙ﾀ ｲ゙ｾ ﾞー ｼｮﾝ
ﾊ ｯ゙ﾌｧの種類

(8x15K、4x44K、2x105K、244K)

2x HI-RPM
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8-8．マイクロアレイの取り扱い上の注意 

 

1x244K タイプのアレイ： 1 枚のスライドに 1 つのマイクロアレイ 

2x105K タイプのアレイ： 1 枚のスライドに 2 つのマイクロアレイ 

4x44K タイプのアレイ： 1 枚のスライドに 4 つのマイクロアレイ 

8x15K タイプのアレイ： 1 枚のスライドに 8 つのマイクロアレイ 

がそれぞれ載っています。 

 マイクロアレイはバーコードラベルに”Agilent”の文字が入っている面に載っています。Agilent の文

字が入っている面が Active サイド、数字だけのバーコードラベルが付いている面は Inactive サイド

です。ハイブリダイゼーションを行う際は、アレイがプリントされている Active サイドに、必ず溶液を

アプライするように注意してください。 

 各オリゴ DNA マイクロアレイのレイアウトやサイズなどの詳細な情報については、付録をご参照くだ

さい。 

 スライドグラスを取り扱う際は手袋をはめ、スライドグラスの縁を注意深く持って取り扱って下さい。ス

ライド表面には両側とも決して触らないで下さい。 

 スライドグラスを取り扱う際は、必ずパウダーフリーの手袋を着用してください。 

 ハイブリダイゼーション、洗浄のステップでアレイを乾燥させないように注意して下さい。 

 ハイブリダイゼーションを行う前に、実験机を整理整頓して下さい。ハイブリダイゼーション器具の周

りはなるべく障害物がない状態を作ってから次ページ以降の操作を行って下さい。 

 ハイブリダイゼーションは水平な実験台で行って下さい。下記ハイブリエイドをお持ちの場合は、内蔵

の水準器で水平が確認できます。ハイブリダイゼーション作業を始める前に、予めご確認ください。 

 手でアレイスライドをガスケットスライドに乗せるのが難しい場合、オプションとして、ハイブリエイドを

用いてアレイスライドを乗せることが出来ます。 

※ ハイブリエイドはハイブリダイゼーション作業を補助するオプションの器具です。 

  



 オリゴ DNA マイクロアレイキット 2 色法プロトコル操作実習テキスト 

 

32 

8-9．ハイブリダーゼーション溶液の調製 

１．10x Blocking Agent の準備 (必要時間 5 分) 

軽くスピンダウンしてペレットをチューブの底に集めた後、ヌクレアーゼフリー水 0.5 mL を Blocking 

Agent に加えます。軽くボルテックスをして、溶解させます。‐20℃で約 2 ヶ月まで保存できます。 

ｓ使用前に凍結した溶液を解かした時には、軽くボルテックスをして完全に溶解してください。 

※ Blocking Agent が完全に溶解しない場合は、37℃で 4-5 分温めて、完全に溶解させて下さい。 

※ Large volume キットをお使いの場合には、ヌクレアーゼフリー水 1.25 mL で溶解してください。 

2．フラグメンテーションの準備 （必要時間 45 分） 

1.5 mL のヌクレアーゼフリーチューブを準備します。 

お使いになるアレイのフォーマットで、試薬の必要量が変わります。以下のステップは、ご使用にな

るアレイフォーマット（8x15K、4x44K、2X105K、244K）をよくご確認のうえ、実施ください。 

フラグメンテーション溶液の調製 

① お使いになるアレイのフォーマットを確認し、下記の表に示したcRNA量になるようにラベル化した

cRNA溶液を調製し、1.5 mLエッペンチューブに入れます。原液、及びあまった希釈液は-80℃で保

管します。凍結融解を繰り返すと、RNAの品質に悪影響を与えますのでご注意ください。 

 

60mer マイクロアレイフラグメンテーションの準備 

 

 

② ヌクリアーゼフリー水の量はcRNAサンプルの濃度によって異なります。上記の表にある最終量に

なるように、ヌクレアーゼフリー水を計算して入れてください。 

 

 

 

  

マイクロアレイ フォーマット 8x15K 4x44K 2x105K 1x244K

リニア増幅Cyanine 3

ラベル化 cRNA
0.3 ug 0.825 ug 0.75 ug 0.75 ug

リニア増幅Cyanine 5

ラベル化cRNA
0.3 ug 0.825 ug 0.75 ug 0.75 ug

10x Blocking Agent 5 uL 11 uL 25 uL 50 uL

ヌクリアーゼフリー水 適量 適量 適量 適量

25 × Fragmentation Buffer 1 uL 2.2 uL 5 uL 10 uL

最終量 25 uL 55 uL 125 uL 250 uL

25 × Fragmentation Buffer 

10x Blocking Agent 

cRNA 

それぞれの必要量は 

アレイフォーマットで 

異なるので注意してください。 

ヌクレアーゼフリー水 
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③ ボルテックスしてよく液を混合します。 

④ ６０℃のウォーターバスまたはヒートブロックで３０分インキュベーションします。必ず遮光してくださ

い。30分を超えてインキュベーションしないでください。 

⑤ 30分後、ただちにサンプルを氷上に移し、1分間冷却します。その後速やかに、フラグメンテーション

をストップさせるために、下記の表を参照して適切な量の 2xGE Hybridization Buffer HI-RPMを

加えます。 

各チューブはバッファを加えるまで氷上においておきます。 

注意 以前発売していた2x GE Hybridization Bufferと2x GE Hybridization Buffer HI-RPM

は別の試薬です。必ず2x GE Hybridization Buffer HI-RPMをご使用下さい。 

 

 

⑥ ピペットでゆっくりと液を混合させます。泡を立てないように十分に気をつけてください。高速でボル

テックスを行うと泡が発生しますので、ボルテックスは使用しないようにしてください。 

⑦ 高速遠心機でスピンダウン(13,000 rpm、1分、室温)して、蓋や壁についた液を底に集めます。 

 

直ちにハイブリダイゼーションに使用してください。保存はできません。 ハイブリダイゼーションのステ

ップに進んでください。 

マイクロアレイフォーマット 8x15K 4X44K 2X105K 1X244K

フラグメンテーションの溶液量 25 uL 55 uL 125 uL 250 uL

2X G E Hybridization Buffer
HI-RPM

25 uL 55 uL 125 uL 250 uL

最終量
(1マイクロアレイあたり)

50 uL 110 uL 250 uL 500 uL
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8-10．ハイブリダーゼーションチャンバの組み立て 

 

ハイブリチャンバを組み立てるにあたり、以下のキットが必要になります。 

ハイブリダイセーションチャンバ (G2534A) 

 

 

 

 

 

 

 

 

 

 

 

ハイブリダイセーション消耗品： 244K 用 (G2534-60003), 2x105K 用 (G2534-60002), 

4x44K 用(G2534-60011), 8x15K 用(G2534-60014) 

 

 

 

 

 

 

 

 

 

■（オプション）ハイブリエイド 

 

 

 

  

チャンバ－ベ－ス

チャンバ－カバ－

クランプ　　
アッセンブリ

スクリュー

ブリッジ

プラスチック製
ピンセット

チャンバ－ベ－ス

チャンバ－カバ－チャンバ－カバ－

クランプ　　
アッセンブリ

スクリュー

ブリッジ

クランプ　　
アッセンブリ

スクリュー

ブリッジ

プラスチック製
ピンセット
プラスチック製
ピンセット

ガスケットスライドガスケットスライド



オリゴ DNA マイクロアレイキット 2 色法プロトコル操作実習テキスト 35 

 

1. ピンセットを使ってガスケットスライドのプラスチックカバーの端をつまみ、ゆっくりとはがします。ガス

ケットスライドをパッケージから取り出します。この時、スライドの縁以外には触れないようにしてくださ

い。必ずパウダーフリーの手袋を着用してください。 

 

 

2. チャンバベースの上に、ガスケットスライドを”Agilent”の文字が書かれている面を上にして載せます。

ガスケットスライドは、ハイブリダイゼーション溶液を介して直接アレイに触れますので、ほこり等がつ

かないようにすばやくセットしてください。 

チャンバベースの 4 つの突起(図の矢印の部分)にしっかりはまるようにします。 

 

 

 

 

 

3. ガスケットスライドがしっかりとチャンバベースにセットされているか確認し、正しくされていない場合は、

再度セットし直してください。 

 

 

 

 

 

 

4. ハイブリダイゼーション溶液をガスケットスライド上にアプライします。 

 

 

マイクロアレイ フォーマット
ハイブリダイゼーション　液量

（１アレイあたり）

8x15K 40 uL

4x44K 100 uL

2x105K 245 uL

1x244K 490 uL
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ハイブリダイゼーション溶液がガスケットのふちまで広がらないように、ガスケットの中央部分にア

プライしてください。スライドガラス上の全てのウェル間で、液面の高さが揃うように、ゆっくりと均

等に液を配置します。 

 

 

 

 

 

 

サンプルをアプライしないウェルがある場合、バーコードに近いウェルにサンプルをアプライし、数

値化に Feature Extraction 9.5 をお使いの場合、空白ウェルはバーコードから遠い位置にして下

さい。Feature Extraction 9.1 をお使いの場合、空白ウェルはスライド中央の 2 アレイに設定して

下さい。 

空白ウェルには、水で 1x の濃度に希釈をした GE Ｈｙｂｒｉｄｉｚａｔｉｏｎ Ｂｕｆｆｅｒ ＨI-ＲＰＭを、アレイの

フォーマットに応じて、上の表の量、アプライして下さい。 

（オプションのハイブリエイド用いる場合、ここで次ページの【参考手法】を参照下さい） 

5. アレイ面(Agilent と書かれているバーコード面) を下して(数字が書かれている方のバーコード面

は上に)、マイクロアレイスライドをチャンバベースにセットされているガスケットスライド上に載せま

す。このとき、アレイスライドの縁またはバーコードシール部分を持つようにしてください。マイクロ

アレイスライドを水平に保ったままガスケットスライドにのせます。 

アレイを正しくセットした後、チャンバや重なっているスライドグラスを動かさないようにしてください。

ハイブリダイゼーション溶液が漏れる原因になります。 

注意 2 枚のスライドのバーコードが、正しい位置で重なり合うようにセットしてください。 

チャンバベースの 4 つの突起(図の矢印の部分)にしっかりはまるようにします。 

 

 

 

 

 

 

注意 １スライドに複数のアレイが搭載されているタイプで、チャンバカバーをセットする前、“サ

ンプル溶液が接しているアレイ”と“接していないアレイ”があるように見える場合がありま

すが、問題ありません。アレイスライドを乗せた後は、位置の微調整などは行わず、すぐ

チャンバカバーを乗せて下さい。 
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※参考手法 

ハイブリエイドを用いることにより、手作業では水平に降ろしづらいマイクロアレイスライドを、サンプルを

アプライしたガスケットスライド上に安定して乗せることが出来ます。 

使用器具： ハイブリエイド (HYB-100) 

 

   

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

① ガスケットスライドにサンプルをアプライし終

わった時点でチャンバベースの両端から各

ハイブリエイドを差し込み、突き当たるまで動

かします。ガスケットスライドの端を、ハイブリ

エイドの突起部分が覆うような形となります。 

 

② アレイ面(Agilent と書かれているバーコード

面) を下にして(数字が書かれている方のバ

ーコード面は上に)、マイクロアレイスライドを

ハイブリエイド上に乗せます。アレイスライド

の縁またはバーコードシール部分を持つよう

にして下さい。バーコードシール側を先にハ

イブリエイドの上に置き、そこを押さえながら

もう片方をゆっくり下に倒すと作業が容易で

す。チャンバベースの 4 つの突起に当たらな

いように注意して下さい。この時、アレイスラ

イドはハイブリエイドに支えられてハイブリ液

には接していません。 

 

③ 左右のハイブリエイドを同時に引き抜いて下

さい。アレイスライドが水平に落ち、ガスケッ

トスライドと正しい位置で重なります。アレイ

スライドを乗せた後は、位置の微調整などは

行わず、すぐチャンバカバーを乗せて下さ

い。引き抜く先に障害物などが無いようにし

て下さい。 
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6. チャンバカバーを、チャンバベースの上にセットします。カバーの向きを間違えないように注意して

ください。 

 

7. クランプアッセンブリを、チャンバベースの丸くなっているコーナー側から差し込み、完全にストップ

する位置まで移動させます。ストップする位置は、ちょうどチャンバの中央部になります。 

 

8. チャンバが水平に保たれていることをご確認した後、手でスクリューをしっかり締めます。チャンバ

にダメージを与える可能性があるので、ペンチなどの道具は決して使用しないでください。 

 

9. 組み立て終了後、チャンバを垂直方向にして 2,3 回、回転させて、ハイブリ溶液がスライドガスケ

ットの全面に行き渡るようにします。次に、チャンバ内の泡が自由に動くことができるか確認してく

ださい。ハイブリ溶液が行き渡っていない部分や、固定している泡により、ハイブリむらが起きる場

合があるので、泡が動かない場合には、チャンバを手で軽く振り、泡を移動させます。 

 

10. 残りのスライドも同様に、上記の作業を行ってください。 
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11. チャンバの組み立てがすべて終わりましたら、予め 65℃にセットしたオーブンのローターに差し

込みます。ハイブリダイゼーション中に外れることがないように、両端をしっかりと差し込んで固

定してください。チャンバが奇数の場合は、必ずブランクのチャンバをセットしてバランスをとるよ

うにしてください。 

 

 

 

12. ハイブリダイゼーションオーブンの扉を閉め、回転数を 10 rpm(8x15K, 1x244K, 2x105K, 

4x44K) に設定します。 

 

13. 65℃で 17 時間ハイブリダイゼーションさせます。 

 

14. 洗浄前日から、Gene Expression 洗浄バッファ 2 とスライドグラス洗浄用ガラス容器(1 個)を

37℃で保温しておきます。 

ハイブリダイゼーション 

オーブンロータ 

(G2530-60029) 

Agilent ハイブリダイゼーション 

オーブン (G2545A) 
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8-11. 洗浄の準備 

 

1.Triton X-102 の Gene Expression Wash Buffer への添加 

 

最終濃度 0.005%になるように、Triton X-102 を Gene Expression Wash Buffer1 と 2 に添加すること

で、マイクロアレイの洗浄におけるアーティファクトの可能性を軽減することができます。 

 

10% TritonX-102 は Gene Expression Wash Pack(5188-5327)に含まれています。単体でもご購入

いただけます(50mL、5185-5975)。 

 

Gene Expression Wash Buffer 1 と 2 の開封時に、以下の方法で 10%Triton X-102 を加えます。 

Triton X-102(5185-5975)は単品で購入することも出来ますが、Gene Expression Wash Pack  

(5188-5327)に付属で必要量が納品されます。 

この操作は、Wash Buffer１にも 2 にも行います。 

開封時に添加すれば、その後洗浄時に添加する必要はありません。 

 

1-1）.ダンボール箱中の容器の、外蓋と中蓋を注意深く開ける 

1-2）.ピペットで 2mＬの 10％ Triton X-102 を容器中の Wash Buffer に加える 

1-3）.中蓋・外蓋をきっちり戻し、5・6 回容器全体を転倒混和して、注意深くかつしっかり混ぜる。 

1-4).中蓋・外蓋を外し、Buffer に添付の蛇口を取り付ける 

1-5).Wash Buffer の容器に『Triton X-102 添加済』と記載し、日付を記録する 

 

Gene Expression Wash Buffer 中の Triton X-102 の最終濃度が 0.005%になれば、開封済みのより

少ない量の Buffer にも添加することができます。 

 

注意 洗浄前日から、Gene Expression 洗浄バッファ 2 とスライドグラス洗浄用ガラス容器(1 個)

を 37℃で保温しておきます。洗浄バッファ 2 を別容器に移して少量温める場合は、蒸発を防

ぐため密閉容器を使用してください。 

 

≪ガラス容器およびチャンバの洗浄法≫ 

洗浄に使用するガラス容器やラック、回転子等はマイクロアレイの洗浄専用にしてください。使用後

は洗剤を使わずに水洗いをしてください。洗剤が残っている器具を使用すると、マイクロアレイに洗

剤が付着し蛍光を発する場合があります。 

 

1. チャンバ、ガラス容器、回転子およびラックを水道水ですすぎます。汚れが気になる場合は、洗

剤がついていないスポンジでこすってください。 

2. 超純水でよくすすぎます。5 回ほどすすいでください。 

3. 埃がつかないように乾燥させます。 
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9．2 日目：実験の前準備 

机の上に、以下のものがあるかどうかをご確認ください。 

(ナ) スライドグラス洗浄ディッシュ（3 または 5） 

(ニ) ステンレス製スライドラック(Thermo Shandon 109) 

(ヌ) スターラー（2 または 4） 

(ネ) 回転子（ラック小（サーモエレクトロン 109）の場合 3.0cm 程度のもの 2 

ラック中（サーモエレクトロン 113）の場合 4.5cm 程度のもの 2）  

  ※回転子の大きさが十分でない場合、洗浄力が弱くなる恐れがあります。 

(ノ) Agilent Gene Expression 洗浄バッファ 1 

(ハ) Agilent Gene Expression 洗浄バッファ 2 (37℃で保温したもの) 

(ヒ) 99.8% アセトニトリル （Sigma-Aldrich 社 271004、オプション） 

(フ) Agilent Stabilization and Drying Solution (5185-5979、オプション) 

(ヘ) タイマー 

(ホ) ピンセット 

(マ) パウダーフリーの手袋 

パウダーフリーの表示があっても、蛍光を持つ粒子が手袋についている場合があります。事

前に、確実に手袋から微粒子が発生しないことをご確認ください。ビーカーに入れた Wash1

の溶液で手袋を事前に洗い、手袋から垂れる Wash 溶液が白濁していないこと、および手

袋をあらった後の、ビーカー内の溶液に微粒子がないことを確認してください。手袋から発生

する微粒子は、アレイの表面に吸着して結果に大きな影響を及ぼします（手袋から粒子が生

じる場合の解体方法は p.39 をご参考ください）。 

 

実験：２日目 

スライドガラスの洗浄 

1. 以下の洗浄バッファを用意します。 

A ： 洗浄液 1: Agilent Gene Expression 洗浄バッファ 1 

B ： 洗浄液 2: Agilent Gene Expression 洗浄バッファ 2 

37℃のウォーターバスまたはオーブンで溶液を加温します。洗浄直前時まで 37℃で保温して下さい。

弊社では、37℃で保温可能なスターラー付恒温槽（アズワン株式会社、品番：1-5088-01、写真参照）

の利用を推奨しております。本実習では、スターラー付恒温槽を利用します。 

C ： アセトニトリル：下記 S&D 溶液を使う場合のみ使用します。ドラフト内で扱ってください。 

D ： S&D 溶液：Agilent Stabilization and Drying Solution ドラフト内で扱ってください。 

取り扱い方法 

Agilent S&D 溶液はアセトニトリルに溶解させたオゾン除去剤を含みます。オゾン除去剤は飽和状

態になっているため、沈殿物を生じる場合があります。目に見える沈殿があった場合には、以下の

手順で溶液を加温して、沈殿物を再溶解してください。 
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注意 Agilent S&D 溶液は、揮発性、引火性の溶液ですので、取り扱いに注意を要して下さい。 

警告 警告に従わず火事、爆発による個人的な傷害を負った場合、アジレントの補償対象外になり

ますので、充分注意して取り扱って下さい。 

警告 S&D 溶液の加温は必ず下記の方法に従って行ない、インキュベーター(孵卵器)などでは行

わないでください。インキュベーター(孵卵器)などを使用して密閉空間で加温すると溶剤であ

るアセトニトリルが気化して充満し、爆発事故や高濃度のアセトニトリルの吸引による健康被

害の原因となる可能性があります。 

 

S&D 溶液加温手順 

必ず下記手順に従って加温してください。 

注意 S&D 溶液を扱う際は、火気は厳禁です。また電子レンジ（オーブン）は使用しないで下さい。

温度を急激に上げないで下さい。さらに、引火性物質を近くに置かないで下さい。 

① ヒュームフード(ドラフト)内で 37-40℃のウォーターバスを用いてゆっくりと溶液を加温します。S&D

溶液はビニル袋に入れてからウォーターバスに入れると、ラベルがはがれません。十分な空気の

ヘッドスペース容量がある容器に溶液をいれ、密閉した状態で加熱してください。 

注意 出荷時に S&D 溶液が入っていたオリジナル容器は加温にお使いいただけます。オリジナル

容器は 700 mL サイズで、500 mL の溶液が入っています。オリジナルと異なる容器を使う場

合には、この空気部分のヘッドスペースと溶液の割合がオリジナル時以上になることをご確

認ください。沈殿物を完全に再溶解させるのに必要な時間は、沈殿物の量によって異なりま

す。沈殿量が多い場合には、オーバーナイトでの加温が必要になることもあります。S&D 溶

液は決してろ過しないでください。 

② 溶液を均一に溶解するために、緩やかな攪拌が必要になる場合があります。必要に応じて、ヒュ

ームフード(ドラフト)内で火気を避けて行ってください。 

③ 沈殿が溶解しましたら、室温に戻してから使用してください。洗浄に使用する際は、マニュアルの

詳細に従って、ヒュームフード（ドラフト）内で行って下さい。 

 

2. 洗浄の準備 

ヒュームフード(ドラフト)内で、下記の通り、４つのディッシュを準備します。 

アセトニトリルおよび S&D 溶液を使わない場合はヒューム･フォード内で扱う必要はありません。 

注意 ハイブリダイゼーションチャンバの分解を始める前に、すべての必要な洗浄液とディッシュの

準備を行ってください。洗浄・乾燥のステップは、できるだけ効率的に行って下さい。 

注意 注意深く洗浄プロトコルに従ってください。また指定の器具を使用してください。洗浄時間を守

ることは非常に重要です。洗浄時間がプロトコルの時間から外れた場合には、結果がばらつ

いてしまう場合があります。また、スライド洗浄を行う際の攪拌には、シェーカーを使わずに、

必ずマグネットスターラを使用して下さい。  
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0 min 5 min

15 min 30 min

3. 洗浄バッファ１を入れたスライドグラス洗浄ディッシュを２つ用意します。 

 ディッシュ 1: ガスケットの解体用。 

 ディッシュ 2: スライドラックと回転子を中に入れておきます。 

 

 

4. 37℃で保温してあるスターラー付恒温槽に、洗浄バッファ２を入れるスライド洗浄ディッシュ（ディッシ

ュ 3）を１つ用意します。回転子を中に入れておきます。そして、37℃で保温してある洗浄バッファ２を

注いで下さい （写真参照）。 

注意 スターラー付恒温槽を利用しない場合、洗浄バッファ１の洗浄が開始するまで、37℃で保温

してある洗浄バッファ２を加えないで下さい。 

5. (オプション) アセトニトリルを入れたスライド洗浄ディッシュを別に１つ用意します。回転子を中に入れ

ておきます。 

6. (オプション) S&D 溶液を入れたスライド洗浄ディッシュを別に１つ用意します。回転子を中に入れてお

きます。このディッシュは、S&D 溶液専用にされることをお勧めします。 

注意 ハイブリダイゼーションチャンバを分解する前に、必ず上記洗浄バッファ、洗浄液の入った４

つのディッシュ全てを準備してください。洗浄の各ステップは、途切れなく効率的に行うことが

重要です。洗浄の途中に準備不足のための待ち時間が発生しないように注意してください。 

7. オーブンからハイブリダイゼーションチャンバを取り出します。複数のアレイをハイブリダイゼーション

している場合も、チャンバは必ず１つずつ取り出すようにしてください。泡が形成されているか、また

泡が自由に動いているか確認してください。 

注意 チャンバをオーブンから取り出し、室温で静置すると、放置時間に応じて、ハイブリ液の覆っ

ている部分と気泡の部分で、シグナル強度に差異を生じます（下図参照）。オーブンから取り

出したチャンバは、必

ずすぐに解体し、アレ

イスライドを Wash1 中

のスライドラックに移

すことが重要です。ま

た複数枚のスライドを

一度に wash する場合

も、1 スライドずつ取り

出し、解体の直前まで、

 

スタラー付恒温槽 

室温放置の影響を検証したデータ 
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規定の温度に保温されていることが重要です。 

8. チャンバを水平な台の上に置き、スクリューを逆時計回りにまわしてゆるめます。 

9. クランプアッセンブリを外し、チャンバカバーを取り除きます。 

10. チャンバベースから、重なっている 2 枚のスライドを同時に取り出します。この時、スライドの両端を

しっかりつかむようにしてください。すぐに、アレイスライドを上にした状態で、スライドが重なってい

る状態で洗浄バッファ 1 をいれたディッシュ 1 に浸けます。 

注意 必ずパウダーフリーであることを確認した手袋をご使用ください。パウダーフリーの表示が

あっても粒子がついている場合があります。これらの粒子が洗浄バッファに混入すると、洗

浄中にアレイに吸着し、強い黄緑色のスペックルとしてアレイに残る恐れがあります。 

11. スライドが完全に洗浄バッファ 1 に浸かった状態で、スライドのバーコード側から 2 枚のスライドを離

します。 

(ア) ピンセットの先端を２枚のスライドの間に差し込み、ゆるやかにピンセットを上側または下側に

回転させてスライド同士を離します。 

(イ) ガスケットスライドのみをスライドグラス洗浄ディッシュの底に

落としてください。  

12. アレイスライドをすばやく取り出し、室温の洗浄バッファ１がはいっ

たディッシュ 2 にセットされているラックにそっと差し込みます。 

注意 スライドグラスを扱う時は、バーコード部分かスライドグラスの縁を持つようにします。決して

マイクロアレイに触れることがないように注意してください。アレイが空気に触れる時間を最

小限に押さえてください。 

 

※参考手法 

ピンセットを用いることにより、洗浄液に手袋を浸さないでアレイを洗

浄することができます。 

使用器具： 超精密ピンセット No.T (品番は p.9 参照)  

 

①2 枚のスライドをピンセットで挟み、 ②バーコード側のピンセットを ③両手でスライドガラスを 

 立てた状態でガラス容器１に入れる。 2 枚のスライドガラス間に入れ しっかりはさみ、 

 アレイ面を傷つけないように ガラス容器２中の 

  ガスケットスライドをはがす。 ラックに運ぶ。 

 1 2 3
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13. 残りのチャンバも同様に解体して、すべてのスライドをラックに差し込みます。一度に洗浄するアレイ

は 8 枚以下にするようにしてください。 

 

注意 スライドグラスをラックに差し込む際は、洗浄の効率を保つ持つために端は 3 つ以上、スラ

イドグラス間は 2 つ以上空けてください。19 スライドラックは最大 5 枚、30 スライドラックは

最大 8 枚洗浄可能です。全てのスライドで、アレイ面がラックの中心を向く向きに揃えます。 

 

19 スライドラック(Ｔｈｅｒｍｏ Ｓｈａｎｄｏｎ109) 30 スライドラック（Ｔｈｅｒｍｏ Ｓｈａｎｄｏｎ113） 

 

 

 

 

 

 

 

注意 全てのスライドを洗浄バッファ 1 で満たされたディッシュ 2 中のスライドラックにセットした後、

37℃で保温状態の洗浄バッファ 2を入れたディッシュ3、アセトニトリルを入れたディッシュ 4、

S&D 溶液を入れたディッシュ 5 のスターラーをあらかじめスタートして、回転子を回しておき

ます。その際、洗浄液 2 が入っているディッシュ 3 の回転速度は中程度（ラックがない状態

で渦ができる程度の回転させてください。）、アセトニトリル、S&D 溶液が入っているディッシ

ュ 4、5 の回転速度は中程度あるいはそれよりも強い程度にしておきます。 

 

14. スターラーで洗浄バッファ 1 を攪拌します。中程度の回転数で、室温のまま１分間 攪拌します。 

注意 スターラー付恒温槽を利用しない場合、洗浄バッファ 1 でスライドガラスを洗浄している間、

ディッシュ 3 に 37℃で保温してある洗浄バッファ２を注ぎます。 

 

15. スライドラックを洗浄バッファ２の入ったディッシュ 3 にすばやく移します。中程度の回転数で 1 分間 

攪拌します。実験を成功させるために、この洗浄時間を厳守してください。 

 

※ S&D 溶液以外のオゾンによる Cy5 蛍光退色の対策が行われている場合 

16. スターラーの回転速度を最低速まで落とし、回転させたままの状態で、スライドラックを極めてゆっく

りかつ一定の速度で洗浄バッファ 2 から引き上げます。スライドラックをできるだけ水平に保ったま

ま、5-10 秒ほどかけてゆっくりと一定の速度でスライドラックを引き上げてください。このステップで

洗浄は終了です。ステップ 20 以降をご覧ください。 
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※ オゾンによる Cy5 蛍光退色の対策として S&D 溶液を用いる場合 

17． 洗浄バッファ 2 からスライドラックを取り出します。この時、少しだけスライドラックを傾け、ラックから

洗浄バッファ 2 をできるだけ除きます。洗浄バッファ 2 のアセトニトリル、S&D 溶液への持ちこみは

最小限にして下さい。アセトニトリル、S&D 溶液を含むディッシュ 4、5 は、あらかじめスターラーが開

始している状態にしておきます。できるだけすばやくスライドラックをアセトニトリルが入ったディッシ

ュに移動させることが重要です。ラックの移動は１０秒未満で行うようにして下さい。その後、ラックを

移したアセトニトリル中で、室温、10 秒間攪拌します。回転速度は中程度あるいはそれよりも強い

程度にします。 

 

18. アセトニトリルからスライドラックを取り出します。できるだけすばやくスライドラックを S&D 溶液が入

ったディッシュに移動させて下さい。その後、ラックを移した S&D 溶液中で、室温、30 秒間攪拌しま

す。回転速度は中程度あるいはそれよりも強い程度にします。 

注意 ラックを S&D 溶液の中に置いた時、白濁が数秒の間生じる可能性があります。これはラッ

クから持ちこされた洗浄バッファ 2 によるもので、パフォーマンスには影響しません。 

注意 次のステップで、スライドラックをゆっくりかつ一定の速度と方向で取り出します。 

 

19. スターラーの回転速度を最低速まで落とし、回転させたままの状態で、スライドラックを極めてゆっく

りかつ一定の速度で S&D 溶液から引き上げます。スライドラックをできるだけ水平に保ったまま、

5-10 秒ほどかけてゆっくりと一定の速度でスライドラックを引き上げてください。スライドラックを溶

液から出したり戻したりしないように注意して下さい。スライドラックを取り出すのが早すぎる場合、

スライドガラス上に白い粒子が生じることがあります。その場合には、直ちにスライドラックを S&D

溶液中に沈めて、再度極めてゆっくりかつ一定の速度で取り出してください。 

注意 S&D 溶液の滴がスライドラック下側のスライドガラスの端に残る場合がありますが、オリゴ

DNA がプリントしてあるアレイエリア内に液滴がなければ、問題ありません。決してスライド

を振らないで下さい。スライドガラスのアレイエリア内に滴がついている場合は、すぐにスラ

イドラックを S&D 溶液に再度浸し、それから再度極めてゆっくりとかつ一定の速度で取り出

してください。 

 

20. この操作でスライドガラスは乾燥しますので、その後ただちにスキャンを行うことができます（窒素ガ

スによる乾燥は必要ありません）。スキャンの操作は P.43 をご覧ください。 

すぐにスキャンをしない場合には、窒素パージして暗所で保管してください。 

注意 S&D 溶液には、オゾン除去剤が含まれていますが、長時間のオゾン暴露によりシグナルは

退色していきます。オゾン暴露を最小限にするために、洗浄とスキャンは早朝または夕方

の遅い時間に行ってください。大気中のオゾン濃度は日中、特に交通量が多い時間帯に最

大になります。Agilent 社のスキャナーをお使いいただく場合には、一度にセットするスライ

ドガラスを 10 枚までにしてください。このようなスキャニグ操作を行うことで、大気中のオゾ

ン暴露を最小限にすることが可能です。 
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21. 蛍光色素の光脱色を防ぐため、スキャン後、スライドグラスはポリプロピレンスライドボックスに入れ

（コルクなどの詰め物をしないでください。）、真空デシケータまたは窒素パージボックスに入れて暗

所で保存します。真空デシケータの方が色素の退色が見られるため、窒素パージボックスをお勧め

しています。 

 

20. S&D 溶液およびアセトニトリルの繰り返し利用回数は 3 回までになります。ただし繰り返し利用でき

る回数は、洗浄バッファ 2 の持ちこみ量によって異なります。 

 

 

≪S&D 溶液の保存≫ 

ヒュームフード（ドラフト）内で、手袋を用いて、S&D 溶液を褐色または透明なガラス容器に移します。液

を移した後、少なくとも 30%以上のヘッドスペースがある大きさのガラス容器をお使いください。漏斗を使

用すると、簡単に溶液を移すことができます。S&D 溶液を移した褐色あるいは透明なガラス容器は、暗

所で保存して下さい。S&D 溶液は初回使用後、2 回まで、合計 3 回まで繰り返し使用できます。S&D 溶

液の繰り返し使用を終了した後は、HPLC 廃液およびフェノール廃棄と同様の方法にて揮発性の溶剤と

して処分して下さい。 

 

≪S&D 溶液を使用したガラス容器およびチャンバの洗浄法≫ 

洗浄に使用するガラス容器やラック、回転子等はマイクロアレイの洗浄専用にしてください。 

アセトトリルあるいは S&D 溶液と接した器具は、ヒュームフード（ドラフト）内で手袋を必ず用いて、水溶

性の有機溶媒（アセトニトリル、アセトン、エタノール）を使って洗浄します。その後、チャンバや洗浄バッ

ファ用のガラス容器と同様に、超純水でさらによく洗浄して下さい。 

使用後は洗剤を使わずに水洗いをしてください。洗剤が残っている器具を使用すると、マイクロアレイに

洗剤が付着し蛍光を発する場合があります。 

 

1. チャンバ、ガラス容器、回転子およびラックを水ですすぎます。汚れが気になる場合は、洗剤がつい

ていないスポンジでこすってください。 

2. 超純水でよくすすぎます。5 回ほどすすいでください。 

3. 埃がつかないように乾燥させます。 
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10．Agilent スキャナを用いたスキャニング 

レーザーを安定させるために、スキャンを開始する 20 分前までにスキャナの電源を入れます。 

PC を起動した後にスキャナの電源を入れ、スキャナコントロールソフトを立ち上げます。 

 

1. スキャニングの準備 

1. スライドをスライドホルダにセットします。スライドホルダをカローセルにセットした際に、数字のバー

コード面が見えるような向きで挿入します。 

 

 

 

 

 

 

 

 

 

 

2. スライドホルダをスキャナのカローセルにセットします。 

 

2. スキャナコントロールソフト ver.7 をお使いの場合 

1. 画面下の”Scanner status”が『Scanner ready』になっていることを確認します。 

2. スライドを入れたスロット番号を、”Start slot”と”End slot”で指定します。 

3. 設定を変更するスライドをテーブル内で選択してください(複数枚選択できます)。選択されると青くハ

イライトされます。 

4. “eXtended Dynamic Range Scan Mode”にチェックを入れ、”Hi”を 100%に、”Lo”を 10%にします。 

5. “Edit Slot Values>>”をクリックしてメイン画面を拡張します。 

 

 

 

 

 

 

 

 

 

 

 

 

 
⑤ 

アレイ面 

ラベルが手前、 

“Agilent”と記載の面 

がホルダの上側に 

くるように挿入 

 奥のつめにのせる 

④ 
レ 

① 

③ 

② 

⑤ 
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6. 拡張された画面で、下の表に従って各種設定変更を行います。 

注意 Scan resolution が 5 ミクロンになっていることを必ず確認してください。 

 

 

 

 

 

 

 

 

 

 

 

7. “Output path”で、スキャン画像を出力したいフォルダを指定します。 

8. 設定が終了したら、”Set Values”をクリックします（Set values をクリックしないと変更が反映されませ

ん）。テーブル内の設定値が変更されたことを確認してください。 

9. スキャン設定が確認できたら、”Scan Slot n-m”をクリックするとスキャンが開始します。 

11.スキャンが終了したら、Scan Progress 画面の右下にある Close ボタンをクリックします。 

スキャナのロックがはずれ、スライドホルダを取り出せるようになります。 

10. コントロールソフトを閉じた後にスキャナおよび PC の電源を消してください。 

【参考】 XDR スキャン 

※eXtended Dynamic range：XDR スキャンは、１枚のスライドグラスを、異なった PMT（4x44K フォーマ

ットの場合、高 PMT：XDR Hi 100％、低 PMT：XDR Lo 10％）に変え、自動的に連続スキャンする機能

です。Feature Extraction 9.1 以降はこの２つのスキャンを自動的に１つにまとめ、広いダイナミックレン

ジが得られる結果を自動的に出力することが可能です。 

⑧ 

⑦ 
⑨ 

⑥ 
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≪スキャンのデフォルト設定変更法≫ 

1. スキャナコントロールソフトを立ち上げ、ツールバーの Settings > Modify Default Settings を選択

します。 

2. 表示された Default Setting ボックス内で、変更したい項目を変更し、OK をクリックします。 

3. スキャナコントロールソフト ver.8 をお使いの場合 

1. 画面下の”Scanner status”が『Scanner ready』になっていることを確認します。 

2. スライドを入れたスロット番号を、”Start slot”と”End slot”で指定します。 

 

 

 

 

 

 

 

 

 

 

 

3. “Profile”リストから、既存のプロファイルを選択します。 

<default> プログラムインストール後に現れるデフォルト設定 

 AgilentHD_GX_2Color 遺伝子発現アレイ 2 カラー 

AgilentHD_GX_1Color 遺伝子発現アレイ 1 カラー 

AgilentHD_CGH  CGH/ChIP マイクロアレイ 

AgilentHD_miRNA  miRNA マイクロアレイ 

① 

② 

⑤ 

④ 
③ 
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4. 選択したプロファイルの項目で、個別に変更する必要があればプルダウンで変更します。 

 変更できる項目 

 1). Dye Channel： Red（1 カラー(Cy5)） 

Green(1 カラー（Cy3）), 

Red+Green（2 カラー） 

 

 2). Scan Region: Full Slide 

 Agilent HD (アジレントアレイ) 

 

3). Scan Resolution: 2um, 3um, 5um, 10um,  

 double path (2um, 3um, 5um) 

 

4). TIFF file dynamic range： 20bit, 16bit  

 

 

5). R/G PMT gain: 100% ～ 1% 

6). XDR ratio: 0.5, 0.33, 0.2, 0.1, 0.05, 

 NoXDR 

 

7). Output Path:  

※変更した設定は Profile に保存することができます。 [Profile > Save as] 

 

5. スキャン設定が確認できたら、”Scan Slot n-m”をクリックするとスキャンが開始します。 

6.スキャンが終了したら、Scan Progress 画面の右下にある Close ボタンをクリックします。 

スキャナのロックがはずれ、スライドホルダを取り出せるようになります。 

7. コントロールソフトを閉じた後にスキャナおよび PC の電源を消してください。 

 

【参考】 16bit スキャンと 20bit スキャン 

※TIFF ファイルに保存されるシグナル強度範囲を指定します。 

20bit スキャンは、1 回のスキャンで 5 桁のダイナミックレンジでシグナル強度を保存できます。XDR スキ

ャンは不要なため、20bit スキャンを選択すると XDR 機能はオフになります。 

16bit スキャンは、1 回のスキャンでは遺伝子発現のダイナミックレンジをカバーしきれないため、XDR

機能を使って 2 回の PMT gain の異なる連続スキャンを行ない、その結果を統合して使います。この場

合、XDR ratio を指定する必要があります。遺伝子発現のデフォルトの XDR ratio は 0.1 です。 

20bit で 1 回スキャンしたデータと 16bit で XDR スキャンをしたデータは、結果にほぼ違いはありません。  
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11．ハイブリダイゼーション後のマイクロアレイの画像化 

 

Image Work Window 

Image Work Window は、下図のような画面構成をしています（この画面は、tif イメージファイルをデスクト

ップの Feature Extraction ショートカット  にドラッグ＆ドロップすることで、立ち上がります）。 

 

 

 

 

 

 

 

 

実習では、アジレントマイクロアレイスキャナーを使用した画像化と、イメージの簡単な確認法をご紹介し

ます。より詳細については、スキャナーに付属の日本語簡易版マニュアルまたは英語版イメージアナリ

シス・マニュアルをご覧ください。 

 

今回は、Image Work Window 内の操作で、アジレントマイクロアレイスキャナーで出力した tif 形式のマ

イクロアレイイメージ画像を用いて、イメージの簡単な確認を行っていきます。 

 

① Feature Extraction ソフトウェアの起動 

スキャンした画像ファイルを開きます。 

tifイメージファイルをデスクトップのFeature Extractionショートカット  にドラッグ＆ドロップ。 

② バックグランドのむらの確認 

ログスケール表示によりバックグランドのむらを確認します。 

 

 

 

 

 

 

 

 

 

ログスケール 

リニアスケール 

切り替えボタン 

 
 

Image Window

Work Area

 

Image Window

Work Area
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③ イメージデータのスケールの確認 

両チャンネルのデータレンジを確認します。 

注意 ここでの確認はイメージデータ全体に対するものとなります（スポット以外のエリアも含みます）。 

スポットレベルで確認する（例：コントロールスポットを除く全遺伝子スポットに対してデータスケールを確認す

る）ためには、スポット定量が必要になりますので御注意ください。 

 

③-1：カラーレンジの設定 

をクリック。 

イメージデータ全体に対し、1％から 99％の設定（デフォルト）

における最大値・最小値を確認します。 

 

 

 

 

 

 

③-2： ヒストグラムの作成 

をクリック。Cropping Mode

を Off にします。 

 

アレイの左上隅で右クリックし、 

そのままポインタをアレイの 

右下隅までドラッグさせます。 

 

上述のカラーレンジの設定と 

併せて、両チャンネルの分布が 

極端に異ならないか確認します。 

 

 

 

 

 

 

④ クロップモードの ON/OFF 

クロップモードが ON の場合、ポインタの横にひし形のマークが表示されます。イメージをクロップすると

新しいウィンドウで切り取った画像が表示されます。OFF の場合、クロップ時にその大きさに合わせてウ

ィンドウが拡大表示されます。 

をクリックすることで ON/OFF の切り替えができます。  
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⑤ カラースワップの確認 

色素交換を行ったアレイがある場合、２枚のアレイイメージを比べて大まかなスワップ傾向が見られるかを調

べます。 

 

 

 

 

 

 

 

 

 

 

 

この傾向を適正に見る為に、カラーレンジの設定を 1％から 99％の 

設定（デフォルト）にしてください。 

設定に応じて、Cy3 の発現量が多い場合に緑色、Cy5 の発現が多い場 

合に赤色になるように表示されます。 

 

 

⑥ ラインプロット 

スポットの形状を確認します。 

 

 

 

 

 

 

 

 

 

 

 

 

ラインプロットを見たい領域の左上隅で左クリックし、そのままポインタを領域の右下隅までドラッグさせます。

次に、ラインプロットを見たい位置（上の図の場合、青線上のどこでも構いません）にポインタを合わせてダブ

ル左クリックします。 

このように、Feature Extraction する前に、ヒストグラムやラインプロットを使ってデータ抽出の妨げの可

能性となる異常スポットやバックグランドの確認をすることができます。 
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スポット数値化と解析 

 

DNA マイクロアレイの解析には 2 種類のソフトウェアを使用します。 

 

まずスキャンで得た TIFF イメージからスポットの数値化を行うソフトウェアが必要になります。ここで

はスポットのシグナル強度、ローカルバックグランドのシグナル強度などが算出されます。Agilent ス

キャナに付属する Feature Extraction ソフトウェアはこれに加えてバックグランドの引き算、色素補

正を行い、最終的な２サンプルの発現比（LogRatio）および統計処理されたエラー値とP値を決定し

ます。 

 

上記のスポット解析を行った数値データを用いて、高度なデータ解析を別のソフトウェアで行います。

一番身近なものではエクセルが挙げられますが、エクセルはアレイごとの結果を解析するのには適

していますが、複数アレイの結果の比較(クラスター解析など)には適していません。データ解析を行

うソフトウェアは数多く製品化されていますが、本トレーニングではエクセルで基本的な解析を行い

数値化のアウトプットデータを理解した上で、Agilent GeneSpring GX を使ったデモを行い、さらに生

物学的意義を付け加えていきます。 

 

Agilent Feature Extraction など    Agilent GeneSpring GX など 

図１．スポット解析、データ解析の流れ 

 

 

スポットの数値化は以下の手順で行われます。 

① スポットのシグナル強度計算 

② バックグランドのシグナル強度計算 

③ バックグランド補正 

④ 色素補正 

⑤ 発現差計算 

 

 

 

 

 

 

 



 オリゴ DNA マイクロアレイキット 2 色法プロトコル操作実習テキスト 

 

56 

 

 

 

 

  

フィーチャのシグナル raw data 平均値

- ピクセルOutlier 計算

- フィーチャUniformity Outlier 計算

- フィーチャPopulation Outlier 計算

gBGUsed バックグランドのシグナル値

- ローカルバックグランド

- グローバルバックグランド

- ピクセル Outlier 計算

- バックグランド Uniformity Outlier 計算

- バックグランド Population Outlier 計算

rBGUsed

gBGSubSignal フィーチャのシグナル raw data 値からバックグランドを引き算rBGSubSignal

gDyeNormSignal rDyeNormSignal 色素補正

- グローバル補正

- コントロール補正

gProcessedSignal rProcessedSignal Surrogate 値の適用
色素補正後シグナル値が 0 以下になった時に使う代替値

→バックグランドの標準偏差値

gMeanSignal rMeanSignal

LogRatio

フィーチャのシグナル raw data 平均値

- ピクセルOutlier 計算

- フィーチャUniformity Outlier 計算

- フィーチャPopulation Outlier 計算

gBGUsed バックグランドのシグナル値

- ローカルバックグランド

- グローバルバックグランド

- ピクセル Outlier 計算

- バックグランド Uniformity Outlier 計算

- バックグランド Population Outlier 計算

rBGUsed

gBGSubSignal フィーチャのシグナル raw data 値からバックグランドを引き算rBGSubSignal

gDyeNormSignal rDyeNormSignal 色素補正

- グローバル補正

- コントロール補正

gProcessedSignal rProcessedSignal Surrogate 値の適用
色素補正後シグナル値が 0 以下になった時に使う代替値

→バックグランドの標準偏差値

gMeanSignal rMeanSignal

LogRatio
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バックグランド補正、色素補正について 

各スポット、バックグランドのシグナル強度を算出した後に行う 2 つのステップです。 

 

バックグランド補正 

アレイのイメージ結果によって、以下の減算法が挙げられます。 

 ローカルバックグランド 

 全ローカルバックグランドの平均値 

 ネガティブコントロールのバックグランド 

 アレイイメージの最低シグナル値（スポット、バックグランド含む） 

 スポットの最低シグナル値 

ローカルバックグランドはスポットの周囲でプローブがスポットされていない部分になります。 

例：ローカルバックグランドの使用 

 

また、以下の補正法が挙げられます。 

 Spatial Detrend 

 Global Adjustment 
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色素補正 

 

Cyanine3、Cyanine5 色素の cRNA への取り込み率の違い(色素バイアス)を解消するために色

素補正を行います。色素補正は次の２つのステップから成ります。 

① 色素補正に使うスポット(遺伝子)の選択 

② 色素補正法の選択 

 

① 色素補正に使うスポット(遺伝子)の選択には以下の３方法があります。 

 グローバル補正：フラグがたっていない全てのスポット(遺伝子) 

Up、または Down と判定される遺伝子の数が少ない場合、または Up、Down と判定

される遺伝子の数が同じぐらいであると予想される場合はグローバル補正（全スポッ

ト）を使います。 

 グローバル補正：Rank Consistency 法を使ってスポット(遺伝子)を選択 

基本的にはグローバル補正ですが、全スポットを使用するのではなく、スポットのなか

でも Cyanine3 と Cyanine5 が central tendency に載っているスポットを選択して、

補正に使用します。選択されるスポットはアレイによって異なります。 

 コントロール補正：「ハウスキーピング」遺伝子 

実験系で発現変動がないとわかっている「ハウスキーピング」遺伝子セットがある場

合は、コントロール補正を使います。 

 

② 色素補正法には以下の 3 方法があります。 

 Linear 法 

バックグランドをひいたシグナル強度に色素バイアス係数をかけて計算します。 

 Linear&LOWESS 法（Locally Weighted Linear Regression） 

Linear 法を適応した後、シグナル強度ごとに色素バイアス係数を計算します。 

 LOWESS 法 

シグナル強度ごとに色素バイアス係数を計算します。 
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12．Feature Extraction ソフトウェアで数値化を行う前に 

- Feature Extraction 画面（ウインドウの構成）の説明 

Feature Extraction Ver.8 以降の画面は、Project Work Window（スポットの数値化の画面）と Image 

Work Window（イメージ確認の画面）があります。 

Project Work Window の画面構成（デスクトップ上の Feature Extraction ショートカット  

から立ち上げた場合の初期画面） 

 

 

 

 

 

 

 

 

 

 

※ Agilent カタログアレイの Design File、Agilent が推奨している Default 設定の Protocol は、Feature 

Extraction をインストールする際に、自動的にインストールされます。しかしながら、最新版の Design File、

Agilent が推奨している Default 設定の Protocol は更新される場合があります。最新版 Design File、

Protocol の後述の弊社 Web サイトからのダウンロードが可能です（p.65-66）。 

 

Grid Template Browser 内に、新規 Design File を加える場合 

ダウンロードした Design File を解凍し、XML ファイルを”日本語が入らないパス”のフォルダに保存します。

Grid Template Browser Pane 上で右クリック→Add…を選択後、目的の Design File を選択して下さい（ま

たは、Tools > Grid Template > Add…を選択後、目的の Design File を選択）。 

※ 圧縮ファイルを解凍する際は、Winzip あるいは Windows XP 以降に付属のソフト（解凍するファイル上で

右クリック＞Open with（プログラムから開く）＞Compressed(zipped)Folders と選択）を使用してください。 

 

各 Design File に Default の Protocol を設定する方法 

Grid Template Browser Pane に格納されている目的の

Design File を選択します。左ダブルクリック（または、Tools > 

Grid Template > Properties を選択）後、FE GridTemplate 

Properties （ 左 図 ） の window が 開 き ま す 。 Default 

Protocol、Default One Color Protocol に適切な Protocol

を指定します。 

FE Protocol Browser 内に、新規 Protocol を加える場合 

FE Protocol Browser Pane 上で右クリック → Import…を選択後、目的の Protocol を選択して下さい。 

（または、Tools > FE Protocol > Import…を選択後、目的の Protocol を選択） 

FE Protocol Browser 各数値化ステップの

アルゴリズムのパラメータを含む、アプリケー

ションごとのファイル。ダブルクリックで開いて

変更・保存可能。 

Grid Template Browser インストール済みの

Design File または Grid File のリスト表示。 

Project 

Explorer  

Pane 

Project Work Window 

QC Metric Set Browser 各アプリケーション

での QC メトリックのセット。 
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13．Agilent Feature Extraction ソフトウェアによる数値化 

Step 1— Feature Extraction ソフトウェアの起動 

Project Work Windowを以下の方法で立ち上げて、スポットの数値化を行います。 

 デスクトップのFeature Extractionショートカット  をダブルクリックします。このショートカットは

Feature Extraction ソフトウェアをインストールした時に自動的に作成されます。 

 Start>Programs>Agilent >Feature Extraction からソフトウェアを開始させます。 

 

Step 2—FE projectへ数値化するイメージ(.tif)を追加 

1. ツールバーにあるAdd New Extraction Set(s)のアイコン をクリックします。あるいは、

Project Explorer内で、右クリックをします。そして、Add Extraction…を選択します。 

2. tif.ファイルを選択して、Openをクリックします。複数のファイルを指定するときには、ShiftまたはCtrlキー

を押しながら選択します。 

※ XDR設定でスキャンしたtif画像は、2種類（1st(H)および2nd(L)）のScan Fileがイメージファイルとして認識

されます。その際、1stおよび2ndのScan Fileが、同一フォルダ内に存在する必要があります。 

3. Project Explorer内のProject下の階層にExtraction Setが、さらにExtraction Set下の階層にImage 

File、Grid Template（あるいはGrid File）、Protocolが現われることを確認して下さい。必要に応じて、

適切なGrid TemplateとProtocolを選択してください。 

 

 

 

 

 

 

 

 

 

 

Project ： Feature Extraction の Run 設定全体をまとめた情報です。1 つ以上の Extraction Set から構成さ

れています。 

Extraction Set ： 解析する tif 画像ごとに作成されます。Image File、Grid Template (Grid File)、Protocol

から構成されています。 

Image File ： 解析対象のマイクロアレイ画像のことです。 

Grid Template (Grid File) ： Grid 情報です。Agilent アレイのお客様は、Design File を意味します。 

Protocol ： イメージの数値化の際、適用する解析アルゴリズムの設定です。 

 

Extraction Set

Image File

Grid Template (Grid File)

Protocol

Project

Extraction Set

Image File

Grid Template (Grid File)

Protocol

Project
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Step 3—Project PropertiesおよびExtraction Set Configurationタブシートでの設定

および確認 

１. Extraction Set Configurationタブシートの確認をします。 

 Extraction Set Configurationタブシートを選択。 

 Extraction Setで用いる構成（イメージ、Design File、Protocolなど）を設定、確認します。 

※ Protocol は8x15K, 4x44K, 2x105K, 1x244K フォーマットアレイの2色法の数値化には、FE9.1では

GE1-v5_91_日付、FE9.5ではGE2-v5_95_日付、FE10.5ではGE2_ 105_日付を選択してください。 

Design FileについてはP.65, ProtocolについてはP.66をご参照ください。 

 

※ XDR設定でスキャンしたtif画像は、2種類（1st(H)および2nd(L)）のScan Fileがイメージファイルと

して認識されます。その際、1stおよび2ndのScan Fileが、同一フォルダ内に存在する必要があり

ます。 

 

プルダウンメニューにgrid templateがない場合に、grid templateをGrid Template Browserに追加して

ください。Grid Template Browserの枠内で右クリックをして、Addを選択します。追加したいデザインフ

ァイル(.xml)をブラウズし、Openをクリックしてデータベースにインポートします。最新のgrid template

にアップデートする場合には、オンラインアップデートをご利用ください。Grid Template Browserの枠

内で右クリックをして、Online Updateを選択します。 

 

2. Project Propertiesタブシートでの設定確認、および設定を行います。 

 Project Propertiesタブシートを選択する、あるいは、Project Explorer内の解析に用いるProjectをダブ

ルクリック。 

 Projectの設定を確認、変更をします（解析結果ファイルのOutputフォルダの設定、結果としてOutput

するファイル種類の設定など）。 

 

Extraction Set Configurationタブシート 
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①出力方法の設定 

出力方法は以下の4つから選択することができます。 

None （出力しない） 

Local file only （ハードディスクに出力する） 

FTP send only （外部にファイルを転送する） 

Both local file and FTP send （両方に出力する） 

 

本実習では、TEXT、Visual Results、QC Reportの結果を出力します。これらの項目の設定を、Local file 

onlyと選択します。また、それ以外の項目（MAGE、JPEG、Grid）は、Noneを選択します。 

 

③ 出力ファイルの設定 

MAGE アレイの結果をXML形式で出力。解析にロゼッタ社のリゾルバー/ルミネーターを使用する場

合、Array Expressにデータを転送する場合などに必要。 

JPEG 各アレイ画像をJPEG形式で出力。この画像ファイルからは数値化はできないので注意。 

TEXT アレイの結果をタブ区切りテキスト形式で出力。解析にGeneSpring、エクセルなどを使用する

場合に必要。 

※ TEXTファイルのOutput設定は、以下のOutput Package設定が可能です。 

Full ： 数値化項目全ての結果を出力します。 

Compact ： 数値化項目の一部（通常、データ解析に用いると考えられる項目）の結果を 

出力します。Fullに比べ、約1/3のファイルサイズとなります。 

GeneSpring, DNA Analyticsを使用する場合はCompact推奨。 

Visual Results 数値化結果のTIFF画像へ重ね描きするのに必要な.shpファイルを出力。 

Grid グリッド合わせの詳細（スポット位置情報など）をCSV形式で出力。 

QC report 実験の成否をチェックするための項目を含んだレポートを出力。 

※ QC reportはPDFファイルあるいはHTMLファイルで出力できます。 

PDFファイルは”Local PDF file only”を、HTMLファイルは””Local HTML file only”を選択

してください。HTMLファイルの場合は数値化後、必ずQCReport_Graphsというフォルダ

と同じフォルダにHTMLファイルを保存してください。 
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Feature Extraction 9.xでQC metricsを出力するにはQC Metric Setの項目GE2_QCMT_日付を選択し

ておきます。Feature Extraction 10.x以降はデフォルト設定で出力されます。 

 

 

 

3. 設定を確認したら、Projectの保存を行います。 

 File > Save As後、Save Asのダイアログ画面が出てきますので、FE Project Data Files (.fep)ファイ

ルを保存するための適切なフォルダを選択および作成して下さい。 

 フォルダ指定後、名前を付けて保存して下さい。 
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Step 4—Feature Extraction Projectをスタート 

 

Project > Start Extractingを選択すると、Projectがスタートします。 

スタート後、Summary ReportタブとRunning Monitorが現われます。 

 

 

 

 

 

 

 

 

進行状況は、Running Monitorに表示されます。Project終了後、Summary Reportタブを選択していると、

Project Work Windowに、Project終了を示すSummaryが現われます。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

※ 4x44K フォーマットの出力結果は、ファイル名末尾 ”…_1” ～ “…_4” の4つのデータが得られます。 

8x15K フォーマットの出力結果は、ファイル名末尾”…_1_1” ～ “…2_4” の8つのデータが得られます。 

それぞれ、下図の位置のアレイに対応しています(バーコードラベルを左側、Inactiveサイトが手前の状態)。 

 

 

 

Summary ReportタブシートSummary Reportタブシート

 

Running MonitorRunning Monitor

 

Project 終了後Project 終了後

1 2 3 41 2 3 4
1_1 1_2 1_3 1_4

2_1 2_2 2_3 2_4

1_1 1_2 1_3 1_41_1 1_2 1_3 1_4

2_1 2_2 2_3 2_42_1 2_2 2_3 2_4



 

Step 5—QC Reportの確認 

 

1. 出力された結果ファイルに、”pdf形式のQCReportファイル”があることを確認して下さい。 

2. ”pdf形式のQCReportファイル”を開いて下さい。QC Reportを確認することができます。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

QC Reportは、以下の項目を示します。 

（各項目の詳細は、Help > Reference Guide で確認することができます。） 

 QC Report Header 

 Spot Finding of Four Corners 

 Outlier Stats 

 Spatial Distribution of All Outliers 

 Net Signal Statistics 

 Plot of Background-Corrected Signals 

 Negative Control Stats 

 Spatial Distribution of Up- and Down-Reguｌated Features 

 Local Background Inliers 

 Foreground Surface Fit 

 Plot of LogRatio vs Average Log Signal 

 Reproducibility Statistics (%CV Replicated Probes) 

 Microarray Uniformity (2-color only) 

 Sensitivity 

 Spike-in Signal Statistics 

 Reproducibility Plot (Spike-ins) 

 LogRatio Plot for Spike-ins 
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Step 6―Visual Resultの確認 

 

Step3で選択したVisual Resultファイルを使ってフラグ等の確認をします。 

1. Feature Extraction内に、XDRスキャンをした1stの画像（ファイル名の末尾に_Hが付いた画像）を表示さ

せます。 

2. メニューバーのFeature Extraction > Load Visual Resultを選択します。 

3. 該当するVisual Resultファイル（.shp）を選択します。このとき表示させている画像に対応するファイルを

選択してください。 

4. 画像にVisual Resultが重ね描きされます。 

5. クロップモードやズームイン機能、ログスケール表示機能を使って表示を調節します。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

6. View > Extraction Results からVisual Resultsの表示法を選択できます。 

 

 

 

 
 

     View outliers onlyにチェックが入っている状態 

 

Help > Feature Extraction Output Quick Referenceで各リングの色が示すアウトライヤーを確認できます。 

 

 

 

 



 

Step7. テキストファイルの確認 

以下の表は、Compact 設定で出力されたテキストファイルの主な項目です。 

通常データ解析では g/rProcessedSignal をシグナル値、ProbeName を ID として使用します。 
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Feature Extraction 由来のフラグ 

 

 コントロールスポットの排除： ControlType→０にします。 

(Agilent コントロールは１または-１で表示されています)。 

 サチュレーションのフラグ： gIsSaturated、rIsSaturated 

サチュレーションしたスポットは１、していないスポットは０で表示されています。 

 各種フラグ： 

① スポットのフラ gIsFeatNonUnifOL、gIsFeatPopnOL 

rIsFeatNonUnifOL、rIsFeatPopnOL 

② バックグランドのフラグ gIsBGNonUnifOL、gIsBGPopnOL 

 rIsBGNonUnifOL、rIsBGPopnOL 

- NonUnifOL は各スポット(バックグランド)内のむら、均一性をみた項目です（１がフラグ、

０がフラグのたっていないスポット）。 

- PopnOL はあるプローブが複数アレイにプリントされている場合、それらのプローブスポ

ット間で均一性があるかをみる項目です（１がフラグ、０がフラグのたっていないスポッ

ト）。 

 バックグランドと有意差がないシグナルスポットのフラグ： 

両側 t 検定により有意差判定を行います。 

gIsPosAndSignif、rIsPosAndSignif 

シグナルが有意である場合は１、差がない場合は０で表示されています。 

 ある閾値よりも低いシグナルスポットのフラグ： 

BGSubSignal の値が、バックグランドの標準偏差*を各アレイフォーマットの最適値倍(2.6

あるいは 13xBGSD：低密度フォーマットは 2.6、高密度フォーマットは 13 が Default)した値

よりも大きいか小さいか、で判定を行います。 

＊ 標準偏差は、1)低密度フォーマット：ピクセルレベルのばらつきを考慮した値、2)高密度 

フォーマット：エラーモデルから算出された値を用いております。 

gIsWellAboveBG、gIsWellAboveBG 

(このクライテリアよりもシグナルが高い場合は１、低い場合は０で表示されています)。 

gIsPosAndSignif、rIsPosAndSignif よりもクライテリアが高くなり、カットオフされる低シグ

ナルのスポット数が多くなります。 

 

 

 

 

 

 

 

 



 

フィーチャエクストラクションの結果解析 

  

サンプル間の発現差を求めるもっとも単純な方法は、Cyanine3 と Cyanine5 の色素強度の比

(FoldChange)になりますが、この方法では以下の図に示したように、Up と Down のスケールが非

対称になってしまいます。コンピュータを用いたデータ解析を進めるためには適切ではありません。 

 

そこで一般的に、Up と Down が対称なスケールになるように、色素強度比の対数(LogRatio)が計

算されています。 

 

フィーチャエクストラクションでは、LogRatio として底が 10 の対数(log10)が用いられています。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Cy3

Cy5

Cy3

Cy5
分数

10 2 3… ∞

UpDown

10 2 3… ∞

UpDown

Ratio:　UpとDown非対称なスケール

Log Ratio:UpとDown対称なスケール

0-2 -1

UpDown

1 2

Log Ratio:UpとDown対称なスケール

0-2 -1

UpDown

1 20-2 -1

UpDown

1 2

LogRatio : log10

Cyanine3色素強度

Cyanine5色素強度
LogRatio : log10

Cyanine3色素強度

Cyanine5色素強度
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マイクロアレイのレイアウト 

 

キットに付属のデザインファイルには、アレイの各プローブの位置情報（レイアウト）やアノテーション情報が含

まれております。このデザインファイルは、アジレント DNA マイクロアレイスキャナーで読み取った向きを基準

として作成されております。弊社のスキャナーはアレイ面を裏側にから、またバーコードを左位置で読み取る

ので、ほとんどの他社製品のスキャナーで読み取ったイメージと向きが異なります。数値化データとプローブ

情報を組み合わせる際には、お使いのスキャナーの読み取り方向にあわせて並び替えたデザインファイルを

お選び頂く必要があります。並び替えたデザインファイルもマイクロアレイキットに付属の CD-ROM に含まれ

ておりますので、次の点をよくご確認したうえ、適切なデザインファイルをお使いください。 

 

 

1) アレイの表面側(front side)からスキャンしているか。(バーコードにAgilentの文字がある側からスキャン) 

2) 得られたイメージ画像が、スライドグラスを横方向（landscape）にスキャンしたものか。縦方向（portrait）

にスキャンしたものか。バーコードが得られたイメージに対して、上下左右のどこに位置しているかでご判

断ください。 

 

 

デザインファイル名には、アレイ種類（Design ID）とファイル更新日の情報が含まれております。 

  

デザインファイル名の例： 

 

 

 

Design ID 



 

Appendix1：Feature Extraction 用デザインファイルのダウンロードサイト 

デザインファイルは eArray からダウンロードすることができます（ご使用の際、ご登録が必要となります）。 

【eArray】 http://www.chem-agilent.com/contents.php?id=29443 

 

1．お使いのマイクロアレイのデザイン番号 (Design ID)を確認します。 

デザイン番号： マイクロアレイのラベルに記載されて

いる 12 桁の番号の「25」に続く 5 桁の番号の頭に「0」

を付けた 6 桁の番号。この 12 桁の番号は Feature 

Extraction の出力ファイルからも確認できます。 

例）12 桁の番号が 251469312345 の場合… [14693]

の頭に「0」を付けた 014693 

 

2．eArray にログイン後、画面右上の 

「Application Type」を Expression に変更。 

 

 

 

 

 

3．HomeタブでMicroarrayにチェックを入れ、Design ID

欄にデザイン番号を入れてSearch。 

 

 

 

 

4．Search 結果から「Download」を選択 

 

5．Internet Explorer の Pop Up Blocker

を Off にし、「EXTERNALFULGEML」

（＝Feature Extraction 用デザインフ

ァイル）をダウンロード 

  

http://www.chem-agilent.com/contents.php?id=29443
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Appendix2：Feature Extraction 用 Protocol のダウンロードサイト 

 

弊社スポット数値化ソフトウェア、Feature Extraction によるスポットの数値化を行う際、イメージの数値

化に適用する解析アルゴリズムを設定した Protocol ファイルが必要です。 

Agilent が推奨している Default 設定の Protocol ファイルは、下記サイトからダウンロードが可能です。 

http://www.genomics.agilent.com/article.jsp?pageId=2037 

 

 

 

※ 2017 年 4 月現在、上記の Protocol のダウンロードが可能です。 

※ プロトコルファイルは、最新のものではなく、お使いの Feature Extraction Software と一致したバ

ージョンをお使い下さい。 

※ 各 Protocol の詳細は、Protocol Use のリンク先をご参照下さい。 

 

 

QC Metric Set のダウンロードサイト 

最新の QC Metric Set は下記サイトからダウンロードできます。Feature Extraction 9.1 以降に対応して

います。 

http://www.genomics.agilent.com/article.jsp?pageId=2041 

http://www.genomics.agilent.com/article.jsp?pageId=2037
http://www.genomics.agilent.com/article.jsp?pageId=2041


 

Appendix3：弊社の DNA マイクロアレイサポート用ホームページ 

弊社の DNA マイクロアレイサポート用ホームページでは、上記のほかにも新製品や最新プロトコル、アプリケ

ーションノートなど様々な情報を掲載しております。 

(アメリカ本社ウェブサイト)  http://www.genomics.agilent.com/en/home.jsp# 

本社のサイトに掲載してありますキャンペーンの中には、日本国内ではご利用いただけないものもございま

すことをご了承ください。 

 

アジレントゲノミクス 日本ウェブサイト 

 

 

 

 

 

 

 

 

 

http://agilentgenomics.jp 

 

 eArray  

 実験に必要なものリスト 

 サポートページ 

サポートページにて、最新版の和文マニュアルを 

ダウンロードすることができます。 

http://agilentgenomics.jp/
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すべての権利は留保されています。著作権法で認められている場合を除き、本書を許可なく複製、改作、

翻訳することは禁止されています。 

 

本和文操作実習テキストの版権は全て Agilent Technologies, Inc.が所有しています。 

 

ご注意 

本書に記載した内容は、予告なしに変更することがあります。 

本書は、内容について細心の注意をもって作成いたしましたが、万一ご不審な点や誤り、記載もれ等、

お気づきの点がございましたら当社までお知らせください。 

当社では、下記の項目を補償の対象から除外いたします。 

ユーザの誤った操作に起因する機器などの損傷、性能上のトラブル、損害 

本キットの本来の用途以外の使用に起因する機器などの損傷、性能上のトラブル、損害 

本プロトコルに以外の方法または試薬を用いたことによる性能上のトラブル、損害。 

 

分析結果に基づく損失 

本書の内容の一部または全部を無断で複写、転載したり、他の言語に翻訳したりすることは法律で禁止

されています。複写、転載などの必要が生じた場合は、当社にお問い合わせください。 

本製品パッケージとして提供した本マニュアル、CD-ROM 等の媒体は本製品用にだけお使いください。 

 

保証 

本書に記載した内容は、予告なしに変更することがあります。 

Agilent Technologies は、本品に関していかなる保証も行いません。これには暗黙の保証、または商品

性および特定目的への適合性が含まれますが、それらに限定されません。 

Agilent Technologies は、本書に含まれている誤植、あるいは本品の性能、または使用に関する偶発的

ないし間接的な損害に関して責任を負いません。 

 

 


